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Einfiihrung

Im Kapitel 6 “Einfuhrung in Vorlagen* wird die Anwendung und die Verwaltung von Formatvorlagen
beschrieben. In diesem Kapitel wird erklart, wie Formatvorlagen erstellt und geandert werden und

welche Einstellmdglichkeiten lhnen in den Dialogfenstern dabei zur Verfuigung stehen. Sie werden
lernen, wie die Einstellungen das Aussehen des Textes beeinflussen und wie Sie diese am besten
fur Thre Dokumente einsetzen. Beispiele und Hinweise verdeutlichen die Auswirkungen der durch-
gefuhrten Anderungen.

Die Seiten im Dialogfensters zum Formatieren der Formatvorlagen gleichen denen fur die manuel-
le Formatierung eines Textes, so dass Sie dieses Kapitel auch als Anleitung und Beispiel dafiir nut-
zen konnen.

Neue Formatvorlagen erstellen

Neben den in LibreOffice vordefinierten Formatvorlagen konnen Sie eigene (benutzerdefinierte)
Formatvorlagen erstellen und verwenden. Sie erstellen neue Vorlagen entweder per Drag & Drop
oder Uber die Schaltflaiche Neue Vorlage aus Selektion 1= ~ ganz rechts im oberen Teil des
Fensters Formatvorlagen (Uber die Funktionstaste F11, das Menl Format > Formatvorlagen oder
das Symbol ] oder @ in der Symbolleiste Format zu erreichen).

Per Drag & Drop wird beispielsweise ein Absatz fertig formatiert, in die Absatzvorlage gezogen
und anschlieRend ein Name zugeordnet.

Bei der Erstellung tber das Dialogfenster Formatvorlagen erfolgen die Einstellungen zentral Gber
ein Dialogfenster und nicht Giber mehrere, verteilte Menlpunkte. Viele Anderungen lassen sich be-
reits vor der Erstellung der eigentlichen Vorlage in einem Vorschaufenster erkennen.

Beide Methoden empfehlen sich, um die Auswirkungen durch Formatierungsanderungen bereits
vor der Erstellung neuer Formatvorlage zu erfassen und zu kontrollieren.

In diesem Kapitel werden nur die Einstellungen tber das Dialogfenster Formatvorlagen beschrie-
ben, da hier die Einstellungen zentral Gber ein Dialogfenster erfolgen kann.

Das Dialogfenster Formatvorlagen

Offnen Sie das Dialogfenster Formatvorlagen. Wahlen Sie die Art der Formatvorlage lber die
Symbolleiste am oberen Rand (Abbildung 1).

Ein Rechtsklick in den darunter liegenden Bereich der Formatvorlagen 6ffnet ein Kontextmenu, aus
dem Sie Neu auswahlen. Wahrend fur die Absatz- und Zeichenvorlagen immer eine der vorhande-
nen Vorlagen als Grundlage fur die neue Vorlage dient, ist das bei den Rahmen-, Seiten- und Lis-
tenvorlagen nicht der Fall. Das erkennen Sie im Dialogfenster fur die neue, noch unbenannte Vor-
lage: Im Feld Verkniipft mit bzw. Beerben fiir die Absatz- und Zeichenvorlage ist die Ausgangs-
vorlage eingetragen. Sie kdnnen an dieser Stelle auch eine andere Ausgangsvorlage oder Keine
wahlen. Fir die Seiten- und Listenvorlagen steht der Eintrag Keine nicht zur Verfligung.

Je nach ausgewahlter Vorlagenart 6ffnen sich unterschiedliche Dialogfenster. Sie sind grof3tenteils
identisch mit denen, die Sie aus der manuellen Formatierung kennen. Wenn Sie also Erfahrungen
mit der manuellen Formatierung von LibreOffice haben, werden Sie die meisten Optionen und Ein-
stellmdglichkeiten bereits kennen.

Die Dialogfenster fiir eine neue und fiir die Anderung bestehender Vorlagen sind
Tipp oftmals dieselben. Bedingte Vorlagen dagegen weichen davon ab. Weitere Infor-
mationen finden Sie unter Arbeiten mit bedingten Absatzvorlagen auf Seite 28.
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Formatvorlagen [

Absatzvorlagen in 7= -<@— Auswahlmenu:
- Gege el A * Neue Vorlage aus Sektion
Zeichenvoriagen ‘GruBforme ‘ - Vorlage aktualisieren

LihOHanduchNami 'V0r|age laden

Rahmenvorlagen argina
Standard |
A Textkorper L s i
Seitenvorlagen —1eqsme Ervckn —{ Gielkannenmodus |

_ Textkorper Einzug F
- Textiorper Einzug negativ
Uberschrift
Uberschrift 1
Uberschrift 2
Uberschrift 3
Uberschrift 4
Uberschrift 5
Uberschrift 6
Uberschrift 7
Uberschrift 8
Uberschrift 9

Uberschrift 10
Unterschrift

Automatisch ‘EL— I Filter

Abbildung 1: Die Formatvorlagen von Writer.

Die Seite Verwalten

Wenn Sie eine neue Vorlage erstellen, sollten Sie als Erstes Uiber die Seite Verwalten der neuen
Vorlage einen aussagekraftigen Namen geben (Abbildung 2). Diese Seite ist fur alle Vorlagenarten
vorhanden, kann aber zwischen den Vorlagenarten etwas variieren.

i Absatzvorlage: Unbenanntl ww
| Gliederung & Mummerierung | Tabulatoren | Initialen | Hintergrund I Umrandung | Bedingung
Werwalten | Einziige und Abstinde | Ausrichtung | Textfluss | Schrift | Schrifteffekt | Position
Formatvorlage
Mame Tabellenlnhalt [TliAutomatisch aktualisieren:
Folgevorlage |Tabe||enInhaIt El
Verknipfen mit |Star1dard El
Bereich |Benutzervorlager1 El
Enthalt

Abbildung 2: Die Absatzvorlage, Seite Verwalten.

Abhéangig von der Formatvorlage konnen Sie auf dieser Seite allgemeine Angaben machen:

* Name: Fur alle Formatvorlagen. Zeigt den Namen der Formatvorlage an. Vergeben Sie
einen Namen fir eine neue Formatvorlage.

* Automatisch aktualisieren (Standard: Nicht aktiviert): Nur fur Absatz- und Rahmenvor-
lagen. Bei aktivierter Option werden Anderungen durch direkte Formatierung (z. B. Uber
das Menu: Format > Absatz) in die entsprechende Formatvorlage geschrieben und alle
Ubrigen Abséatze im Dokument, die ebenfalls auf dieser Formatvorlage beruhen, werden au-
tomatisch angepasst.

Achtung Wenn Sie gewoéhnlich die direkte (manuelle) Formatierung verwenden, vergewis-
sern Sie sich, dass die Option Automatisch aktualisieren nicht aktiviert ist. An-
dernfalls kénnen Teile des Dokuments unerwartet neu formatiert sein.
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* Folgevorlage Standard: Name der Formatvorlage): Nur fur Absatz- und Seitenvorlagen.
Damit legen Sie die Formatvorlage fiir den nachfolgenden Absatz oder die nachfolgende
Seite fest. So kdnnen Sie beispielsweise einer linken Seite eine rechte folgen lassen. Ein
Beispiel weiter unten verdeutlicht die Verwendung (s.a. Seite 43). Die Eigenschaft Folge-
vorlagen wird haufig fur vordefinierte Absatzvorlagen fir Listen oder Aufzahlungen ver-
wendet.

*  Verkniipft mit: Nur fur Absatz-, Zeichen und Rahmenvorlagen. Beim Erstellen einer neuen
Formatvorlage wird:

° Die neue Formatvorlage wird mit der Formatvorlage verknlpft, die Sie Uber
Rechtsklick ausgewéhlt haben, um diese neue Formatvorlage zu erstellen.

° Der Name der Giber Rechtsklick ausgewahlten Formatvorlage wird in das Feld Ver-
kniipft mit eingetragen.

° Die Eigenschaften der Gber Rechtsklick ausgewahlten Formatvorlage wird in die neue
Formatvorlage Ubernommen.

* Bereich: Fur alle Formatvorlagen. Hier legen Sie fest, in welchem Bereich die Formatvor-
lage sichtbar ist. Den Bereich kdnnen Sie unterhalb der Formatvorlage filtern.

Beachten Sie, dass Sie fur die von LibreOffice vordefinierte Formatvorlagen den
Bereich nicht &ndern kdnnen. Die Verwendung des Filters bietet sich an, wenn Sie
A bestimmten Formatvorlagen anzeigen lassen wollen - z.B. alle verwendeten oder
die miteinander verknupften Formatvorlagen (hierarchisch).

Achtung

« Enthdlt: Zeigt eine Zusammenfassung der Eigenschaften der Formatvorlage.

Verkniipfte Vorlagen

Neue Zeichen- oder Absatzvorlagen erstellen Sie, indem Sie eine
vorhandene Vorlage als Ausgangsvorlage verwenden. LibreOffice
verknlpft die beiden Vorlage miteinander. Ubersehrit 4

Uberschrift

Anderungen an der Ausgangsvorlage fiihren dazu, dass bei den - .
ubernommenen Eigenschaften auch die neu erstellte Vorlage geén- Uberschrift 2
dert wird. Sie kdnnen die Abhangigkeiten in der hierarchischen An- Uborechrift 3
sicht des Formatvorlagenfensters sehen. So ist jede Uberschriften-
vorlage, wie Uberschrift 1, Uberschrift 2 usw. mit der Formatvorlage Uberschrift 4
Uberschriften verbunden (Abbildung 3).

Mit verknipften Vorlagen lassen sich ganze ,Familien“ von Vorlagen
erstellen und deren Eigenschaften gleichzeitig andern.

Abbildung 3: Hierarchische
Ansicht verkniipfter Vor-
lagen.

Ein Beispiel: Wenn die Uberschriften - wie in diesem Handbuch -
grun erscheinen sollen, brauchen Sie nur die Schriftfarbe der Ubergeordneten Vorlage &ndern, um
auch die Schriftfarbe der abgeleiteten Formatvorlagen zu andern.

Beachten Sie bitte, dass Anderungen, die Sie bereits an untergeordneten Formatvorlagen vorge-
nommen haben, nicht von Anderungen der Uibergeordneten Formatvorlagen betroffen sind. Haben
Sie also im obigen Beispiel der Uberschrift 2 bereits eine Schriftfarbe, so wird diese bei Anderun-
gen der Schriftfarbe in der Formatvorlage Uberschriften nicht geandert. Im Bereich Enthélt auf der
Seite Verwalten kénnen Sie sehen, welche Eigenschaften gegeniiber der iibergeordneten Format-
vorlage geandert wurden. Bei den Zeichen- und Absatzvorlagen kénnen Sie iber die Schaltflache
Standard die geanderten Werte auf die Werte der ibergeordneten Formatvorlage zuriick setzen.
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Noti Fir Seiten-, Rahmen- und Listenvorlagen kénnen Sie keine hierarchischen Vor-
otiz lagenstrukturen definieren.

Verkniipfte Formatvorlagen erstellen
Eine verknipfte Formatvorlage lasst sich auf zweierlei Weise erstellen:

* Die Ausgangsvorlage wird in das Feld Verkniipft mit auf der Seite Verwalten im Dialog-
fenster Formatvorlagen eingetragen oder

* durch Rechtsklick auf eine vorhandene Formatvorlage und Auswahl des Menlpunktes Neu
aus dem sich 6ffnenden Kontextmend.

Beispiel: Anderung der iibergeordneten Formatvorlage

Um beispielsweise die Schriftart aller Uberschriften, nicht nur die Schrift der Formatvorlage Uber-
schrift 1 oder Uberschrift 2 zu &ndern, nutzen Sie die Vorteile der verknupften Formatvorlagen.

Offnen Sie das Dialogfenster Formatvorlagen (iiber die Sondertaste F11 oder das Menl Format
> Formatvorlagen) und wéhlen Sie mit einem Rechtsklick auf die Formatvorlage Uberschrift aus

dem Kontextmenii den Eintrag Andern.
Im geodffneten Dialogfenster fiir die Absatzvorlage Uberschrift selektieren Sie die Seite Schrift

und andern dort die Schriftart und gegebenenfalls den Schriftschnitt (Stil) und die Schriftgro3e (Ab-
bildung 4). Uber die Schaltflache OK tibernehmen Sie die Anderungen und verlassen das Dialog-

fenster wieder.

F .l
Absatzvorlage: LibOUberschrift ﬁ
Gliederung & Mummerierung I Tabulatoren | Initialen J__H'Lntergrund | Umrandung
Verwalten I Einzige und Abstinde | Ausrichtung | Textfluss | Schrift | Schrifteffekt I Position

Schrift Stil GroBe
Fett 140 %
T - | 5o 2% :
Liberation Sans MNarrow 125 % 1l
Liberation Serif Kursiv 130 % E
LilyUPC — | |Fett Kursiv 135%
Linux Biclinum G =
Linux Libertine Display G 145 %
Linux Libertine G 150 %
Lucida Console 155 %
lurida Sans Lnicode i 160 % X
Sprache |Deutsch (Deutschland) El
Fir Ausdruck und Anzeige am Bildschirm wird die gleiche Schriftart verwendet.
Liberation Sans
QK J l Zuweisen ‘ ’ Abbrechen l l Hilfe ‘ l Zurick l [ Standard
Abbildung 4: Die Absatzvorlage LibOUberschrift, Seite Schrift.

Damit werden in einem Schritt die Schriftart in allen verkntpften Ubersc_:_hriften-FormatvorIa__gen
(Uberschrift 1 bis Uberschrift 10) geédndert. Abbildung 5 zeigt links die Uberschriften 1 bis Uber-
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schrift 4 und rechts dasselbe Dokument mit einer in der Formatvorlage Uberschrift geanderten
Schriftart.

" Titel (Uberschrift 1) | Titel (Uberschrift 1)
Untertitel 1 (Uberschrift 2) Untertitel 1 (Uberschrift 2)
Abschnitt 1.1 (Uberschrift 3) Abschnitt 1.1 (Uberschrift 3)
Abschnitt 1.2 (Uberschrift 3) Abschnitt 1.2 (Uberschrift 3)
Unterabschnitt 1.2.1 (Uberschrift 4) Unterabschniit 1.2.1 (Uberschrift 4)
Untertitel 2 (Uberschrift 2) Untertitel 2 (Uberschrift 2)

Abbildung 5: Anderung der Schriftart der (ibergeordneten Absatzvor-
lage ,Uberschrift: Links Arial, rechts Times New Roman.

Absatzvorlagen

In diesem Abschnitt werden die Parameter der Absatzvorlage beschrieben. In den meisten Féllen
ist es ausreichend, einige Werte zu andern - insbesondere wenn Sie abgeleitete Formatvorlagen
verwenden oder eine neue Formatvorlage auf Basis einer vorhandenen erstellen wollen. Die Werte
brauchen also nicht jedes mal neu eingegeben werden.

Einziige und Abstande

Auf der Seite Einziige und Abstédnde (Abbildung 6) legen Sie die Werte fur den Einzug, den Ab-
stand zwischen den Absatze und den Zeilenabstand fest. Im rechten Teil wird eine Vorschau zu
den Anderungen angezeigt. Uber die Schaltflache Zuweisen werden die eingestellten Werte auf
den aktuellen Absatz anwendet.

Fur einen Absatz konnen Sie im Bereich Einzug die folgenden Parameter einstellen:

* Vor Text (Standard: 0,00 cm): Abstand vom linken Seitenrand zum Text bzw. zu Nummerie-
rungs- oder Aufzahlungszeichen. Negative Werte lassen den Absatz vor dem eingestellten
linken Rand beginnen. Das kann hilfreich sein, wenn bei sehr breiten linken Randern eine
Uberschrift nur auf einer Zeile erscheinen soll. Bei von links nach rechts verlaufenden
Sprachen (wie z.B. bei der deutschen Sprache) wird der linke Rand des Absatzes vom lin-
ken Seitenrand aus eingeriickt. Bei von rechts nach links verlaufenden Sprachen (wir z.B.
bei der arabischen Sprache) wird der rechte Rand des Absatzes vom rechten Seitenrand
aus eingeruckt.

* Hinter Text (Standard: 0,00 cm): Abstand vom rechten Seitenrand zum Text. Negative
Werte lassen den Text Giber den eingestellten rechten Rand flieRen. Bei von links nach
rechts verlaufenden Sprachen wird der rechte Rand des Absatzes vom rechten Seitenrand
aus eingertckt. Bei von rechts nach links verlaufenden Sprachen wird der linke Rand des
Absatzes vom linken Seitenrand aus eingertickt.

* Erste Zeile (Standard: 0,00 cm): Riickt die erste Zeile eines Absatzes zusétzlich um den
angegebenen Wert gegentiber dem Wert im Feld Vor Text ein. Ein negativer Wert erzeugt
einen hangenden Einzug, d. h. die erste Zeile beginnt vor den anderen Zeilen des Absat-
zes. Um die erste Zeile eines nummerierten oder mit Aufzahlungszeichen versehenen Ab-
satzes einzuriicken, wahlen Sie im Menu Format > Nummerierung und Aufzahlungszei-
chen und dort die Seite Position (siehe auch Listenvorlagen, Seite Position, S. 53).

Absatzvorlagen 9



* Automatisch (Standard: Nicht aktiviert): Rickt den Absatz automatisch im Verhaltnis zur
Schriftgréfe und zum Zeilenabstand ein. Die Einstellung im Feld Erste Zeile wird dann

ignoriert.
Absatzvorlage: LibOTextk&rper &J
Gliederung & Nummerierung | Tabulatoren | Initialen | Hintergrund I Umrandung
Verwalten Einzdge und Abstinde | Ausrichtung I Textfluss | Schrift I Schrifteffekt | Position
Einzug
Vor Text: 0,00 cm| |2
Hinter Text: 0,00 cm <
Erste Zeile: 0,00 cm -
[ Autematisch [ ]
|
Abstand
Uber Absatz: 0,00 cm -
Unter Absatz 0,21 cm =
[] Keine Abstinde zwischen Absitzen derselben Vorlage
Zeilenabstand
Briach 5] ven
Registerhaltighkeit
["] Berticksichtigen
QK H Zuweisen H Abbrechen H Hilfe H Zurick H Standard
Abbildung 6: Die Absatzvorlage, Seite Einzlige und Absténde.

Im Bereich Abstand auf der Seite Einziige und Abstande lassen sich die Abstande tber und unter
einem Absatz festlegen. Ublicherweise wird bei Uberschriften ein Abstand zum vorhergehenden
Text eingehalten. Auch zwischen einzelnen Abséatzen werden mitunter andere Abstande eingestellt,
z. B. bei Aufzahlungen und Nummerierungen. Diese Absténde sollten Sie ohne leere Absatze
(durch Dricken der Enter-Taste) erzeugen. Die in diesem Dokument verwendeten Formatvorlagen
sind so konfiguriert, dass zwischen den einzelnen Abséatzen etwas Platz gelassen wird.

« Uber Absatz (Standard: 0,00 cm): Abstand zum vorhergehenden Absatz.
* Unter Absatz (Standard: 0,00 cm): Abstand zum nachfolgenden Absatz.

* Keine Abstande zwischen Abséatzen derselben Vorlage (Standard: Nicht aktiviert): Zwi-
schen den Absétzen der gleichen Formatvorlage werden Abstandsangaben ignoriert und
kein Abstand eingefiigt.

Der Bereich Zeilenabstand legt den Abstand der Zeilen innerhalb eines Absatzes fest. Uber eine
Auswahlliste stehen die Werte zur Verfliigung:

* Einfach (Standard): Im ausgewéahlten Absatz wird ein einzeiliger Abstand eingestellt. Der
Abstand selber wird anhand der Schriftgro3e berechnet. Der einzeilige Zeilenabstand ist
die Standardeinstellung.

* 1,5-zeilig: Stellt im Absatz einen 1,5-zeiligen Abstand ein.
* Doppelt: Stellt im Absatz einen zweizeiligen Abstand ein.

* Proportional: Stellt im Absatz einen in Prozent anzugebenden Abstand ein. Im Feld von
ist der entsprechende Wert einzugeben. Der Wert 100 % entspricht einem einzeiligen und
200 % einem zweizeiligen (doppelten) Abstand.

Absatzvorlagen 10



* Mindestens: Setzt einen Mindestabstand zwischen den Zeilen eines Absatzes.

* Durchschuss: Flugt zwischen zwei Zeilen einen zusatzlichen, im Feld von einzutragenden
Wert als Hohenabstand ein.

* Fest: Setzt einen festen Zeilenabstand zwischen den Zeilen eines Absatzes. Der Abstand
ist im Feld von einzutragen. Bei einem zu geringem Abstand werden die Buchstaben oben
von der daruber liegenden Zeile abgeschnitten.

Wenn Sie innerhalb eines Absatzes unterschiedliche SchriftgréRen verwenden,
passt LibreOffice den Zeilenabstand automatisch an die grof3te verwendete

Tipp Schriftgrof3e an. Falls Sie lieber einen fir alle Zeilen gleichen Abstand fir die Zei-
lenabstéande Mindestens oder Fest wiinschen, kénnen Sie im Feld von einen
Wert angeben, der auch fir die gréf3te verwendete Schrift hoch genug ist.

Im Bereich Registerhaltigkeit konnen Sie die Option Beriicksichtigen aktivieren (Standard: Nicht
aktiviert).

Registerhaltigkeit ist ein typografischer Ausdruck besonders fir das Drucken von Bichern, Zeitun-
gen und Zeitschriften. Damit werden die Zeilen auf der Vorder- und Riickseite einer Seite oder ei-
nes Buchumschlages so ausgerichtet, dass Zeilen auf beiden Seiten exakt auf derselben Héhe lie-
ge. Kontrolliert wird das Register beim Drucken, indem die Seite gegen das Licht gehalten wird
und somit der Stand des Elementes (Zeilen, Zeilenhdhe, Rander usw.) durch das Papier hindurch
betrachtet werden kann. Ist ein Text registerhaltig, so liegen z. B. die Zeilen einer Buchseite exakt
Ubereinander.

Diese Funktion lasst sich nur einsetzen, wenn die Option Registerhaltigkeit fir die aktuelle Sei-
tenvorlage aktiviert ist. Hierzu wahlen Sie Format > Seite..., klicken auf das Register Seite und ak-
tivieren die Option Registerhaltigkeit im Bereich Layouteinstellungen.

Ausrichtung

Uber die Seite Ausrichtung lasst sich die Ausrichtung des Absatzes in Bezug auf die Seitenrander
festlegen (Abbildung 7).

Absatzvorlage: LibOTextkSrper L-s-:._hj

|-___Gliederung&Nummerier_ung Tabulatoren | Initialen i___l—_|_i_r_1tergrund | Umrandung

i_-‘u‘emalten | Einziige und ﬁiiustﬁnde_i Ausrichtung | Textfluss i Schrift i Schrifteffekt i Position |

Optionen
o firis
) Rechts
| Zentriert
") Blocksatz

Letzte Lejle:

WOrt gustrerben

EINZEINES

[¥] Am Textraster fangen (wenn aktiviert)

Text-an-Text
Ausrichtung: IAutnmati sC h-E

Abbildung 7: Die Absatzvorlage, Seite Ausrichtung.

Die einzelnen Felder im Bereich Optionen haben dabei die Bedeutung:
* Links (Standard): Der Absatz wird linksbiindig ausgerichtet.
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Rechts: Der Absatz wird rechtsbiindig ausgerichtet.
Zentriert: Der Absatz wird zentriert ausgerichtet.

Blocksatz: Richtet den Absatz als Blocksatz aus, d. h. der Text wird am linken und am
rechten Rand biindig ausgerichtet. Fur diese Option sind weitere Einstellungen méglich:

° Letzte Zeile: Diese Option ist nur fur die Ausrichtungsart Blocksatz verfiigbar. Die
Ausrichtung der letzten Zeile des Blocksatzes kann verschieden sein:

¢ Links: Die letzte Zeile wird linksbiindig ausgerichtet. Das ist normalerweise die
Standardeinstellung.

¢ Zentriert: Die letzte Zeile wird zentriert ausgerichtet.

¢ Blocksatz: Auch der letzte Satz wird als Blocksatz formatiert. Dabei wird der Ab-
stand zwischen den Worten so eingestellt, dass die Worte Uber die ganze Ab-
satzbreite ausgedehnt wird. Bei nur wenigen Worten in der letzten Zeile, kann
der Abstand sehr grof3 werden (Abbildung 8).

Blocksatz: Auch der letzte Satz wird als Blocksatz formatiert. Der Abstand zwischen den
Worten so eingestellt, dass die Worte tiber die ganze Absatzbreite ausgedehnt werden. Bei
nur wenigen Worten kann der Abstand sehr grof} werden.

Abbildung 8: Die letzte Zeile wird ebenfalls als Blocksatz ausgerich-
tet, die Worte werden (ber die gesamte Absatzbreite ausgedehnt.

° Einzelnes Wort austreiben: Besteht die letzte Zeile des Absatzes aus einem einzel-
nen Wort, so wird dieses Wort Uber die gesamte Absatzbreite ausgedehnt. Der Ab-
stand zwischen den einzelnen Buchstaben des Wortes kénnen dabei sehr grol3 wer-
den (Abbildung 9).

Einzelnes Wort austreiben: Steht ein einzelnes Wart in der letzte Zeile, so wird dieses (iber
die gesamte Absatzbreite ausgedehnt und die Buchstabenabstinde dabei kénnen sehr grofd
W e r d e n

Abbildung 9: In der letzten Zeile wird das einzelne Wort (ber die ge-
samte Absatzbreite ausgedehnt.

° Am Textraster fangen: Der Absatz wird an einem Textraster ausgerichtet. Diese Opti-
on ist nur verfiigbar, wenn die Asiatische Sprachunterstiitzung aktiviert ist (iber das
Menl Extras > Optionen > Spracheinstellungen > Sprachen im Bereich Standard-
sprachen der Dokumente die Option Asiatisch). Das Textraster aktivieren Sie tGber
das MenU Format > Seite, Reiter Textraster.

Auf der Seite Ausrichtung stellen Sie im Bereich Text-an-Text die senkrechte Ausrichtung des
Textes ein, wenn im Satz Zeichen mit Uber- oder UntergroRen auftreten. Setzen Sie den Cursor in
den zu formatierenden Absatz oder markieren Sie mehrere Abséatze und wéahlen die Ausrichtung
aus dem Aufklappmenti:

Automatisch (Standardeinstellung): Writer richtet den Text automatisch aus.

Grundlinie: Die kleineren Zeichen eines Textes werden an der Grundlinie der groRen Zei-
chen ausgerichtet.

Oben: Die kleineren Zeichen eines Textes werden an der oberen Linie der grol3en Zeichen
ausgerichtet.

Mitte: Die kleineren Zeichen eines Textes werden mittig an den grol3en Zeichen ausgerich-
tet.

Unten: Die kleineren Zeichen eines Textes werden an der unteren Linie der grol3en Zei-
chen ausgerichtet.

Abbildung 10 zeigt Beispiele flr die vertikale Ausrichtung.
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Sphinx spms Sphinx Sphinx — Automatisch

Sphinx sth Sphinx Sphinx — Grundlinie
Sphinx ***** Sphinx Sphinx — Oben
Sphinx sehnx Sphinx Sphinx — Mitte

ISphinx sy Ophinx Sphinx — Unten

Abbildung 10: Text-an-Text-Ausrichtung auf der Seite
Ausrichtung der Formatvorlage fiir Absé&tze.

Textfluss

Auf dieser Seite kontrollieren Sie den Textfluss, wie Silbentrennung und Umbriiche (Abbildung 11).
Im Bereich Optionen sind weitere typografische Einstellungen méglich.

Absatzvorlage: LibOTextk&rper lé]

| Gliederung & Nummerierung I Tabulatoren I_ Initialen | Hintergrund I Umrandung |
| Werwalten I Einziige und Abstinde I Ausrichtung | Textfluss | Schrift I Schrifteffekt I Position |

Silbentrennung
¥l Automatisch;
g = Zeichen am Zeilengnde
2 +| Zeichen am Zeilenanfang
0 +| Maximal aufeinander folgende Trennstellen
Umbriiche
l:iﬁinf'ugen T eite Position  |Vor

P T nP i (S P [ T L T r M
mit Seitenvaorlage Seitennummer (0

Optionen
Absatz nicht trennen

[C] Mit folgendem Absatz zusammenhalten

[¥] Schusterjungenregelung 2 S| Zeilen
& Hurenkinderregelung 2 | Zeilen
QK ] | Zuweizen I l Abbrechen | I Hilfe | l Zuriick | | Standard

5 -

Abbildung 11: Die Absatzvorlage, Seite Textfluss.

Der Bereich Silbentrennung legen Sie die Einstellungen fir die Silbentrennung fest:

* Automatisch (Standard: Nicht aktiviert): Diese Option schaltet die automatische Silben-
trennung fir den ganzen Absatz ein oder aus und fligt die notwendigen Trennstriche ein.
Die Silbentrennung erfolgt dann wahrend der Eingabe.

* Zeichen am Zeilenende (Standard: 2 Zeichen): Hiermit legen Sie die minimale Anzahl an
Zeichen fest, die mindestens am Ende der Zeile verbleiben missen, bevor ein Trennstrich
eingefligt wird.

* Zeichen am Zeilenanfang (Standard: 2 Zeichen): Minimale Anzahl an Zeichen, die min-
destens am Anfang der neuen Zeile stehen mussen, nachdem ein Trennstrich eingefugt
wurde.

Absatzvorlagen 13



Maximal aufeinander folgende Trennstellen (Standard: 0): Geben Sie an, in wie vielen
aufeinander folgenden Zeilen maximal eine Trennung stattfinden darf. Null bedeutet in je-
der Zeile.

Wenn Sie mit dem Ergebnis der Silbentrennung nicht einverstanden sind, kénnen
Sie Uber das Menu Extra > Sprache > Silbentrennung die Silbentrennung noch

Tipp einmal anstol3en oder selbst bedingte Trennstriche Uber die Tastenkombination

Strg+(Minus) (-) eingeben.

Im Bereich Umbriiche legen Sie die Bedingungen fiir die Seiten- und Spaltenumbriche fest. Dazu
gehoren die Art und Position des Umbruchs, die Formatvorlage der neuen Seite und die Seiten-
nummer, mit der die neue Seite beginnt, wenn z. B. auf der neuen Seite ein neues Kapitel beginnt.

Im Einzelnen habe die Felder die Bedeutung:

Notiz

Einfligen (Standard: Nicht aktiviert): Aktivieren Sie dieses Feld, um einen Seiten- oder
Spaltenumbruch einzufligen. Erst wenn dieses Auswahlfeld markiert ist, werden die ande-
ren Felder verfugbar:

° Seite: Seitenumbruch

° Spalte: Spaltenumbruch

Typ: Uber eine Auswabhlliste kdnnen Sie einen Seiten- oder Spaltenumbruch auswahlen.
den Sie einfigen mdchten.

Position: Geben Sie an, an welcher Position der Umbruch eingefiigt werden soll:

° Vor: Vor der aktuellen Cursorposition.

° Hinter: Hinter der aktuellen Cursorposition.

mit Seitenvorlage: Aktivieren Sie dieses Feld und wahlen Sie aus der Auswabhlliste die ge-
winschte Seitenvorlage fir die erste Seite nach dem Umbruch aus. Die aufgefiihrten Sei-

tenvorlagen entsprechen den Vorlagen im Formatvorlagenfenster (das erreichen Sie Uber
die Tastenkombination F11 oder Uber das Meniu Format > Formatvorlagen.

Seitennummer (Standard: 0): Geben Sie die Seitenzahl ein, die auf der ersten Seite nach
dem Umbruch erscheinen soll. Fir die Fortsetzung der aktuellen Seitennummerierung ge-
ben Sie "0" ein.

Umbriiche lassen sich auch tUber das Ment Einfligen > Manueller Umbruch ...
einflgen.

Soll die erste Seite eines neuen Kapitels mit einer rechten Seite anfangen, mus-
sen Sie, falls nicht vorhanden, zuerst eine Seitenformatvorlage fiir eine rechte Sei-

Notiz te im Formatvorlagenfenster erstellen (Menl Format > Formatvorlagen oder

Sondertaste F11). AnschlieRend kdnnen sie diese dann im Feld mit Seitenvorlage
auswabhlen.

Der Bereich Optionen bietet lhnen Einstellméglichkeiten fur die Absétze vor und hinter dem Text-
umbruch:

Absatz nicht trennen: Der Absatz wird bei einem Umbruch nicht getrennt. Passt der Ab-
satz nicht auf die Seite, so wird der Absatz komplett an den Anfang der nachsten Seite ver-
schoben.

Mit folgendem Absatz zusammen halten: Hiermit legen Sie fest, dass der aktuelle Absatz
mit dem folgenden Absatz auf derselben Seite steht. Das ist z. B. bei Uberschriften oder
EinfUhrungssétzen zu Auflistungen sehr nitzlich.
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* Schusterjungenregelung (Standard: 2): Die Schusterjungenregelung ist eine typografi-
sche Regel, die festlegt, wie viele Zeilen eines Absatzes mindestens vor einem Seiten-
oder einem Spaltenumbruch stehen bleiben miissen. Aktivieren Sie dieses Markierfeld und
geben Sie die gewiinschte Anzahl in das Feld Zeilen ein. Stehen vor dem Umbruch weni-
ger Zeilen als im Feld Zeilen angegeben, wird der gesamte Absatz hinter den Umbruch ver-
schoben.

* Hurenkindregelung (Standard: 2): Die Hurenkindregelung ist eine typografische Regel,
die festlegt, wie viele Zeilen eines Absatzes nach einem Seiten- oder einem Spaltenum-
bruch mindestens stehen missen. Aktivieren Sie dieses Markierfeld und geben Sie die ge-
winschte Anzahl in das Feld Zeilen ein. Stehen nach dem Umbruch weniger Zeilen als im
Feld Zeilen angegeben, wird der Umbruch entsprechend versetzt und es werden leere Zei-
len vor dem Umbruch eingeflgt.

Schrift

Uber die Seite Schrift (Abbildung 12) legen Sie zusammen mit den Seiten Schrifteffekte und Po-
sition wesentliche Elemente fir das Aussehen Ihres Dokumentes fest. Viele der hier beschriebe-
nen Optionen werden auch fur die Erstellung neuer Zeichenvorlagen verwendet (s. “Zeichenvor-
lagen“ ab S. 30).

F N
Absatzvorlage: Standard ﬁ
Gliederung & Mummerierung | Tabulatoren | Initialen | Hintergrund I Umrandung
Werwalten I Einziige und Abstinde I Ausrichtung I Textfluss | Schrift | Schrifteffekt | Position

Schrift Stil Grofe
'_iberatiun Serif Standard 12 pt
Liberation Serif - 0 pt -
LilyUPC Fett 10 pt
Linux Biclinum G Kursiv 10,5 pt E
Linux Libertine Display G Fett Kursiv 11 pt
Linux Libertine G 3
Lucida Conscle 13 pt
Lucida 5ans Unicode 14 pt
Malgun Gothic 15 pt
Mannal ol 16 nt ol
Sprache | Deutsch (Deutschland) IEI
Fiar Ausdruck und Anzeige am Bildschirm wird die gleiche Schriftart verwendet.

Liberation Serif

QK H Zuweisen H Abbrechen H Hilfe H Zuriick H Standard

A ¥l

Abbildung 12: Die Absatzvorlage, Seite Schrift.

Die Anderungen beziehen sich auf die aktuelle Auswahl bzw. auf das Wort, in dem sich der Cursor
befindet, oder aber auf den danach eingegebenen Text.

Je nach Spracheinstellung wird die Formatierung fiir eine Auswahl der folgenden Schriftarten ge-
andert:

» Schriftart fir westlichen Text - lateinische Zeichensatze.
» Schriftart fur asiatischen Text - chinesische, japanische oder koreanische Zeichensétze.
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» Schriftart fir CTL (Complex Text Layout) - Textlaufrichtung von rechts nach links.

Um die Unterstitzung fur bidirektionale und ostasiatische Schreibweisen zu akiti-
Tipp vieren, wahlen Sie tber das Menu Extras > Optionen... > Spracheinstellungen >
Sprachen und aktivieren die entsprechende Option.

Die Seite Schrift unterteilt sich in mehrere Bereiche.

Schriftart und Schriftschnitt

Im Bereich Schrift wéahlen Sie aus den installierten Schriftarten die gewtlinschte Schriftart aus. Im
unteren Bereich sehen Sie eine Vorschau auf die aktuelle Schriftauswahl.

Die Schriftart lasst sich auch tGber die Symbolleiste Formatierungen aus der ausklappbaren Aus-
wabhlliste Schriftart auswéhlen (Abbildung 13). Diese Auswabhlliste zeigt ebenfalls eine Vorschau,
wenn unter dem Menipunkt Extras > Optionen > LibreOffice > Ansicht das Feld Schriftarten-
vorschau aktivieren markiert ist.

© |standard || 0 o] 2 [ aa@ a4 & a

m

Arial Black

Batang Clg=
BatansChe Clg=1
Browalia New fgawTing

Abbildung 13: Schriftartenvorschau der Auswahllis-
te in der Symbolleiste Formatierungen.

Schriftgrée

Im Bereich Groe geben Sie die Schriftgréf3e ein oder wahlen Sie die gewlinschte Schriftgrof3e
aus. Normalerweise wird die Schriftgrof3e in pt angegeben. Fir skalierbare Schriftarten kdnnen Sie
auch Dezimalwerte eingeben oder die Grol3e mit LAngeneinheit angeben, z. B. cm oder mm.

Relative SchriftgréBe

Wenn Sie eine Absatzvorlage auf Grundlage einer anderen Formatvorlage erstellen, haben Sie die
Mdglichkeit, die SchriftgroRe relativ zu der zugrundeliegenden Formatvorlage festzulegen. Der
Wert wird in Prozent oder als Point-Wert mit einem ,+“- oder ,-“-Zeichen angegeben:

* Prozent-Angabe: Ein Prozent-Wert von 150 % bedeutet dann, dass die Schriftgro3e in der
abgeleiteten Formatvorlage um 50 % grof3er ist als die Schriftgro3e der verknipften For-
matvorlage. Betrug die Schriftgréf3e der verknipften Formatvorlage 10 pt ist diese in der
neuen Formatvorlage 15 pt.

* Angabe als Absolutwert in pt: Der Point-Wert wird mit einem ,+“- oder ,-“-Zeichen ange-
geben. So bedeutet z. B. ,-2 pt* eine Schriftgrof3e, die um 2 pt kleiner ist als die ursprungli-
che Formatvorlage; ,+5 %" bedeutet eine um 5 % grofRere Schriftart.

Dazu ein Beispiel: Sie erstellen eine Absatzvorlage Uberschrift 1 mit der SchriftgroRe 16 pt.
Fur die Absatzvorlage Uberschrift 2, die Sie aus der Formatvorlage Uberschrift 1 ableiten,
soll die Schriftgrof3e 14 pt betragen. Um die Verhéltnisse der SchriftgréZen auch bei der
Anderung der SchriftgréRen beizubehalten, geben Sie fir die Absatzvorlage Uberschrift 2
fur die SchriftgroRRe ,-2 pt* ein. Dann ist fur die Formatvorlage Uberschrift 2 die SchriftgroRe
immer 2 pt kleiner.

Genauso konnen Sie die Angabe fiir skalierbare Schriften in Prozent machen, erhalten
dann aber ungerade pt-Werte: Die Formatvorlage Uberschrift 2 hitte bei ,-20 %" dann eine
SchriftgréRe von
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16 pt—20 % von 16 pt =16 pt — 3,2 pt = 12,8 pt.

Weitere Optionen zu Zeichenformatierung finden Sie im Abschnitt ,Eine neue Zeichenvorlage er-
stellen,, auf Seite 31.

Sprache

Mit der Sprache, die Sie unter Extras > Optionen > Spracheinstellungen > Sprache fir lhr Do-
kument festgelegt haben, bestimmen Sie auch die zu verwendende Rechtschreibprifung, den
Thesaurus, die Silbentrennung, die Dezimal- und Tausendertrenner und das Wéahrungsformat.

Die Rechtschreibprifung fiir die gewahlte Sprache funktioniert nur, wenn das ent-
Notiz sprechende Sprachmodul installiert ist. Ein Spracheintrag ist mit einem Hakchen
versehen, wenn die Rechtschreibprifung flr diese Sprache aktiviert wurde.

Fur jeden Absatz Ihres Dokumentes kdnnen Sie eine separate Sprache einstellen. Diese Einstel-
lung Uberschreibt die Spracheinstellung, die Sie fiir das gesamte Dokument getroffen haben.

Die installierten Sprachpakete sind in der Auswahlliste mit einem Symbol versehen - bestehend
aus einem kleinen ABC und einem Hékchen (Abbildung 14).

Sprache

A

Fir Ausdrf  peytsch (i schtenstei ] art verwendet,

Deutsch (Luxemnburg)
“% Deutsch (Osterreich)
‘% Deutsch (Schweiz)
Dondo
& Englisch (Australien)

Abbildung 14: Die Absatzvorlage, Seite Schrift, installierte Sprachpakete.

m

Fur die Rechtschreibpriifung verwendet Writer fir jeden Absatz das zur jeweiligen Sprache geho-
rende Worterbuch. Wenn Sie Dokumente in mehreren Sprachen verfassen, kénnen Sie Absatzvor-
lagen fir jede Sprache, aber mit sonst gleichen Einstellungen erstellen, so dass Sie mit der Zuwei-
sung eines Textes zu einer Absatzvorlage auch gleich die richtige Sprache festlegen.

Einzelne Worter einer anderen Sprache werden im Text von der Rechtschreibprifung markiert. Um
auch hier auf korrekte Rechtschreibung prifen zu kénnen, markieren Sie das Wort oder die Woérter
und ordnen diesen Uber die Zeichenformatierung (Meni: Format > Zeichen, Seite Schrift) die
richtige Sprache zu.

Schrifteffekt

Auf der Seite Schrifteffekte lassen sich die Absatze vielféltig anpassen (Abbildung 15). Hier kdn-
nen Sie fUr einen Absatz verschiedene Zeicheneffekte Uiber Markierfelder oder Auswabhllisten ein-
stellen:

e die Schriftfarbe,

» Uber-, Unter- und Burehstreichen jeweils mit verschiedenen Linienarten,
« das wortweise Uber-, Unter- und Durchstreichen,

« die Farbe fir das Uber- und Unterstreichen,

* die Schriftdarstellung mit Kontur, Schatten, blinkend (blinkend ist nattrlich nicht auf dem
Papier erkennbar!) oder (den ausgeblendeten Text kbnnen Sie nur sehen, wenn Sie unter
dem Menlpunkt Extras > Optionen > LibreOffice Writer > Formatierungshilfen das
Auswahlfeld Versteckter Text im Bereich Anzeigen aktiviert haben),

» die Schriftdarstellung mit =rhzibenen oder verticfien Relief und
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» die Schriftdarstellung mit diversen Schrifteffekten: GROSSBUCHSTABEN (nur Grossbuch-
staben), gemeine (nur Kleinbuchstaben), Titel (Jeder Anfangsbuchstabe Wird GroR3
Geschrieben) und KapTALCHEN.

Absatzvorlage: Standard ﬁ

Gliederung & Nummerierung I Tabulatoren I Initialen | Hintergrund I Umrandung
Verwalten Einzige und Abstinde | Ausrichtung | Textfluss | Schrift | Schrifteffekt | Positien

Optionen
Schriftfarbe Uberstreichung Farbe
|(Ohr1e) |Z| |__| Automatisch |
Effekte Durchstreichung
|(Ohne) -] |(Ohne) -]
Relief Unterstreichung Farbe
|(Ohne) IZ| |(Ohr1e) IZ| |__| Automatisch
[ Kentur Wortweise
[7] Schatten
[ Blinkend

[} Ausgeblendet

Liberation Serif

l QK H Zuweizen ” Abbrechen ” Hilfe ” Zurick ” Standard

Abbildung 15: Die Absatzvorlage, Seite Schrifteffekt.

Derartige Schrifteffekte werden oftmals nur fiir einzelne oder einige wenige Worte verwendet.
Dann sollten Sie diese Worte markieren und Uber eine Zeichenvorlage formatieren.

Im unteren Bereich dieser Seite sehen Sie eine Vorschau auf das Aussehen der Zeichen. Weitere
Informationen zu Zeichenvorlagen finden Sie unter "Zeichenvorlagen” ab Seite 30.

Position

Auf dieser Seite der Absatzvorlage (Abbildung 16) legen Sie die Position, Skalierung, Rotation und
Laufweite der Zeichen eines Absatzes fest. Fir einzelne oder wenige Zeichen oder Worte sollte die
Formatierung Uber Zeichenvorlagen erfolgen. Im unteren Teil dieser Seite wird eine Vorschau zu
den Einstellungen angezeigt.

Ublicherweise wird fiir einen normalen Text eine Schriftart onne Hoch- oder Tiefstellungen verwen-
det. Im Bereich Position legen Sie die Optionen fir die Hoch- oder Tiefstellung fest:

* Hoch: Verringert die Schriftgrof3e des ausgewahlten Texts und stellt den Text Gber die
Grundlinie.

* Normal (Standard): Keine Hoch- oder Tiefstellung.

* Tief: Verringert die SchriftgréRe des ausgewdahlten Texts und stellt den Text unter die
Grundlinie.

Fir die beiden Optionen Hoch und Tief sind weitere Einstellungen maoglich:

* HochITief um: Geben Sie an, um wie viel Prozent der ausgewahlte Text in Bezug auf die
Grundlinie hoch- oder tiefgestellt werden soll. 100 % entspricht dabei der Schrifthdhe.

* Automatisch (Standard): Der Wert, um den der ausgewahlte Text in Bezug auf die Grund-
linie hoch- oder tiefgestellt zu stellen ist, wird automatisch festgelegt.
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» SchriftgréBe rel.: Geben Sie die Prozentzahl ein, um die Sie die Schriftgrof3e des ausge-
wahlten Textes reduzieren mdchten.

Absatzverlage: Standard lﬁ

Gliederung & Nummerierung I Tabulatoren I Initialen | Hintergrund | Umraldung_|

Verwalten Einzige und Absténde | Ausrichtung | Textfluss I Schrift | Schrifteffekt I Position

Position

estellt
@ ali

O Tiefgestellt

Rotation / Skalierung
@ 0Grad ()90 Grad () 270 Grad

Breite skalieren 100 % =

Abstand

n um (0.0 pt || [¥] Paarweises Kerning

Liberation Serif

0]4 ] I Zuweisen ‘ ’ Abbrechen ‘ ’ Hilfe ‘ | Zuriick ‘ I Standard

Abbildung 16: Die Absatzvorlage, Seite Position.

Im Kapitel 4 Seitenformatierung dieses Handbuches wird die Formatierung von Kopf- und Ful3zei-
len mit Hilfe von rotiertem Text beschrieben. Diese Formatierung kénnen Sie auch Uber separate
Absatzvorlagen fir die Kopf- und FuRzeilen erreichen, wie sie hier beschrieben wird.

In diesem Bereich Rotation/Skalierung legen Sie fir den ausgewahlten Text Optionen fest, die Ih-
nen erlauben den Text zu drehen oder die Schriftweite zu variieren (Beispiele: Abbildung 17):
* 0 Grad (Standard): Dreht den ausgewahlten Text nicht bzw. dreht ihn wieder auf 0 Grad.
* 90 Grad: Dreht den ausgewahlten Text um 90 Grad nach links.
* 270 Grad: Dreht den ausgewahlten Text um 90 Grad nach rechts.

* Breite skalieren: Geben Sie den Prozentsatz der Schriftweite ein, um welchen der ausge-
wahlte Text horizontal gedehnt oder komprimiert werden soll.

Beispiel: Rotierter Text in Absatzvorlagen
Als Beispiel sollen die Uberschriften einer bereits bestehenden Tabelle hochkant gestellt werden:

1) Erstellen Sie eine neue Absatzvorlage (Formatvorlagenfenster oder F11) > Rechtsklick auf
bestehende Absatzvorlage (z. B. Standard) > Aus dem Kontextmeni Neu wahlen).

2) Geben Sie der neuen Vorlage einen passenden Namen (z. B. Tabellentberschrift, rotiert).

3) Auf der Seite Position der neuen Absatzvorlage wéahlen Sie im Bereich Rotation/Skalie-
rung die Option 90 Grad aus.

4) Speichern und verlassen Sie das Dialogfenster mit OK.
5) Weisen Sie einer Uberschrift aus der Tabelle die eben erstellte Absatzvorlage zu.
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6) Um die Uberschriften nach oben oder unten auszurichten, wahlen Sie aus dem Menii Ta-
belle > Tabelleneigenschaften ..., Seite Textfluss, Bereich Ausrichtung aus der Auswahl-
liste des Feldes Vertikale Ausrichtung den Eintrag oben oder unten.

Alternativ lasst sich die Ausrichtung Uber das Meni Format > Ausrichtung und dann im
unteren Bereich Uber die EintrAge oben oder unten einstellen.

In Abbildung 17 sehen Sie Beispiele flr einen Text, der um 0°, 90° und 270° rotiert wurde.

Text um 0~
gedreht.

gedreht.
L0L7 W )XaT,

Textum 90
JNPIPAs

Abbildung 17: Bei-
spiele ftir rotierten
Text.

Im Bereich Abstand lasst sich der Abstand zwischen den einzelnen Zeichen festlegen. Aus der
Auswabhlliste Abstand kénnen Sie den Zeichenabstand wahlen:

» Standard: Es wird die fur die Schriftart festgelegte Laufweite verwendet.
* Gesperrt: Der Abstand zwischen den Zeichen wird vergré3ert.
* Schmal: Der Abstand zwischen den Zeichen wird verringert.

* um (Standard: 0): Das Feld ist nur fur die Abstande Gesperrt und Schmal zuganglich. Die
Angabe in pt (Punkt) legt fest, mit welcher Laufweite (Zeichenabstand) der Absatz ausge-
dehnt oder komprimiert werden soll.

* Paarweises Kerning (= Unterschneidung; Standard: ein): Kerning/Unterschneidung ist ein
typografischer Begriff und passt den Zeichenabstand fur bestimmte Buchstabenkombinatio-
nen automatisch an. Durch Unterschneidung von Zeichen verbessert sich die Lesbarkeit ei-
nes Textes (Abbildung 18). Kerning ist nur flr bestimmte Schriftarten verfligbar und muss
auch vom jeweiligen Drucker unterstitzt werden.

VA VA

Abbildung 18: Beispiel fiir Paarweises Kerning:
ausgeschaltet (links) und eingeschaltet
(rechts).

Tabulatoren

Im Dialogfenster fir die Absatzvorlagen kénnen Sie die Art und Position der Tabulatoren fiir einen
Absatz festlegen (Abbildung 19). Mit Tabellen lassen sich Texten, Abbildungen, Formeln und ande-
re Objekte entsprechend den eigenen Vorstellungen auf einer Seite anordnen. Die Tabellen kon-
nen dabei mit oder ohne Rahmen angezeigt werden. Oftmals sind Tabulatoren jedoch fir die For-
matierung ausreichend. Sie lassen sich einfacher erstellen und flexibel handhaben.

Um Tabulatoren fiir einen Absatz zu setzen, missen Sie die Position, die Art des Tabulators, die
Fullzeichen bis zum Text festlegen und die Schaltflache Neu driicken. Die Positionsangabe erfolgt
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in cm, wenn keine Mal3einheit angegeben wird. Sie kdnnen auch andere Mal3einheiten wie z. B.
mm oder Zoll angeben. Der Abstand wird zum linken Rand gemessen. Leider ist es nicht moglich,
bereits definierte Tabulatoren zu andern. Diese missen Sie I6schen und dann neu mit den ge-
wlnschten Parametern festlegen. Bereits vorhandenen Tabulatoren werden im unteren Teil des
Bereiches Position angezeigt.

Abszatzvorlage: Standard &J
!l_\u‘;{'ﬂralten _]____E_inzﬂgeugd Abstﬁndg_‘__ﬂg_;_r_i_c___lj_'gy_gg_"_i_'l_'erl:fluss | Schrift | Schrifteffekt | Position i
| Gliederung & Nummerierung | Tabulatoren l Initialen ; Hintergrund I Umrandung |
Position Art Fiillzeichen
m @ Links L @ Keine Neu
! Rechts o] B
- | Alle |Gschen |
) Zentriet L oz
7 Dezimal & L
Zeichen Zeichen A
Abbildung 19: Die Absatzvorlage, Seite Tabulatoren.

Achtung

A

Wenn Sie ein Dokument mit Tabulatoren zur Formatierung an andere Beteiligte im
odt-Format verschicken, verwenden Sie nicht die Standardeinstellung fuir Tabulato-
ren, sondern setzen Sie eigene Tabulatoren. Ansonsten kann das Dokument ein
ganz anders Aussehen bekommen, wenn der Empfanger andere Standardabstén-
de fiir seine Tabulatoren eingestellt hat. Um dasselbe Layout zu erhalten, definie-
ren Sie deshalb in den verwendeten Abséatzen oder Absatzformatvorlagen die not-

wendigen Tabulatorabstande.

Die Ausrichtung eines Textes oder von Zahlen richtet sich nach der Art des Tabulators (Beispiele

siehe Abbildung 20):

4 5 6 7 § 10 11

Ho
B

Tabulator 1

................................................................... 1,23

latoren.

Abbildung 20: Beispiel fiir linke, rechte, zentrierte und Dezimaltabu-

* Links (Standard): Der Text wird linksbiindig am Tabulator ausgerichtet.
* Rechts: Der Text wird rechtsbiindig am Tabulator ausgerichtet.
* Zentriert: Der Text wird zentriert am Tabulator ausgerichtet.

* Dezimal: Der Dezimaltrenner einer Zahl (z. B. das Komma in der Zahl 123,45) wird mittig
am Tabulator ausgerichtet. Reiner Text wird links davon ausgerichtet. Das als Dezimaltren-
ner verwendete Zeichen wird von der Gebietseinstellung des jeweiligen Betriebssystems

vorgegeben.

° Zeichen: Hier kénnen Sie ein anderes Zeichen eingeben, dass als Dezimaltrenner fr

den Tabulator verwendet werden soll.
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Beispiele fir die Ausrichtung des Textes an den verschiedenen Tabulatorarten und fur Fillzeichen
sehen Sie in Abbildung 20.
Fullzeichen vor Tabulatoren verwenden Sie z. B. flr Formulare zur Eingabe von Text, fur Inhalts-

verzeichnisse oder Sachregister. Im Bereich Fillzeichen kdnnen Zeichen ausgewahlt werden, die
den Zwischenraum bis zum né&chsten Text ausfillen.

» Keine: Es werden keine Fillzeichen eingesetzt. Vorhandene Fillzeichen links neben dem
Tabulator werden geléscht.

* ........ Der Leerraum links des Tabulators wird mit Punkten aufgefuillt.
LEEEEEE : Der Leerraum links des Tabulators wird mit Minuszeichen aufgefullt.
. : Der Leerraum links des Tabulators wird mit einer durchgezogenen Linie aufgefullt.

» Zeichen: Der durch den Tabulator frei gehaltene Leerraum wird mit dem von lhnen vorge-
gebenen Zeichen aufgefiillt.

Es ist nicht moglich, Tabulatoren auf3erhalb der Seitenrénder zu definieren. Falls
Notiz das notwendig sein sollte, so verwenden Sie dazu Tabellen oder Rahmen ohne
Umrandung.

Gliederung & Nummerierung

Die Seite Gliederung & Nummerierung (Abbildung 21) ermdéglicht lhnen Absétze zu nummerieren
oder mit Aufzahlungszeichen zu versehen, wie z. B. Uberschriften oder Listen. Die Art der Numme-
rierung oder Aufzahlungszeichen kann in Listenvorlagen festgelegt werden.

F -
Absatzverlage: Standard Léj
Verwalten I Einzige und Absténde | Ausrichtung | Textfluss I Schrift | Schrifteffekt | Positicn
Gliederung & Mummerierung | Tabulatoren | Initialen | Hintergrund I Umrandung

Gliederung

Gliederungsebene:

Aufzihlung/Nummerierung
Listenvorlage: Keine El

Zeilennummerierung

[7] An diesem Absatz neu beginnen

=

eginnen mit 1

Abbildung 21: Die Absatzvorlage, Seite Gliederung & Nummerierung.

Mochten Sie ein Dokument mit Gliederung und Inhaltsverzeichnis erstellen, wie
z.B. eine wissenschatftliche Arbeit oder ein Buch, so sollten Sie eine Unterteilung in
Kapitel vornehmen. Dazu ordnen Sie unter dem Menupunkt Extras > Kapitelnum-

Tipp merierung ..., Seite Nummerierung den einzelnen Gliederungsebenen eine Ab-
satzvorlage zu, beispielsweise der Gliederungsebene 1 die Absatzvorlage Uber-
schrift 1. Daneben konnen Sie fir die Gliederungsebenen den Einzug, die Aus-
richtung und den Abstand der Nummerierung zum Text festlegen.

Im Bereich Gliederung legen Sie Uber das Auswahlfeld Gliederungsebene die Ebene fest, die
dem Absatz zugeordnet werden soll. So ist die in Writer vordefinierte Absatzvorlage Uberschrift 1
der Ebene 1 und die Absatzvorlage Uberschrift 2 der Ebene 2 zugeordnet.
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Die aus dem Bereich Aufzdhlung/Nummerierung auszuwahlende Listenvorlage missen vorher
als Listen- oder Nummerierungsvorlagen definiert worden sein. Wenn Sie in einem Absatz Listen
oder Aufzahlungen bestimmte Formatierungen zuweisen wollen:

* Erstellen Sie eine neue Listenvorlage (s. Neue Listenvorlagen erstellen, Seite 51).

» Selektieren Sie aus der Auswahlliste Listenvorlage die neue erstellte Vorlage.

* Speichern Sie die Einstellung mit OK.
Weiterfiihrende Informationen und ein Beispiel fir diese Zuordnung finden Sie unter Beispiel: Er-
stellen einer einfachen Liste auf der Seite 59.
Im Bereich Zeilennummerierung stehen Ihnen mehrere Optionen zu Verfiigung:

* Die Zeilen des Absatzes mitzdhlen (Standard: Aktiviert): Wenn Sie in einem Dokument
Zeilen nummerieren mochten, so kdnnen Sie durch deaktivieren dieses Feldes die ausge-
wéhlte Absatze (die vorher markierten Absétze) von der Zeilennummerierung ausschlie-
Ren.

* An diesem Absatz neu beginnen (Standard: Nicht aktiviert): An diesem Absatz beginnt
die Zeilennummerierung neu.

° Beginnen mit: Legen Sie die Zeilennummer fest, mit der eine neue Zeilennummerie-
rung begonnen werden soll.

Initialen

Die Verwendung von Initialen ist vielfach aus Blichern oder Romanen bekannt. Auf der Seite Initia-
len (Abbildung 22) legen Sie die Eigenschaften der Initialen fest, die sich auch Uber mehrere Zei-
len erstrecken kann:

Absatzvorlage: Textkarper lﬁj
I Verwalten | EiangeundAb_s_tﬁnde - Ausric!’)tur}_g_m_._._ Ta:c!:ﬂE : Schrif‘t_:= Schrif‘teffelct_ 18 Position il
| Gliederung & Nummerierung | Tabulatoren | Initialen | Hintergrund | Umiandung | Bedingung |
Einstellungen

[¥] Initialen anzeigen

[ Ganzes Wort A

Anzahl der Zeichen: i]. =
Zeilen: 3 =
Abstand zum Text: 0,00 cm (5

Inhalt

Zeichenvorlage ![Keine] B

Abbildung 22: Die Absatzvorlage, Seite Initialen.

In den Bereich Einstellungen und Inhalt stehen mehrere Optionen zur Verfligung, deren Auswirkun-
gen im Vorschaufenster im rechten Teil der Seite zu sehen sind:

* Initialen anzeigen (Standard: Nicht aktiviert): Schaltet die Initialen fur den ausgewahlten
Absatz ein.

* Ganzes Wort: Zeigt den Anfangsbuchstaben des ersten Wortes im Absatz als Initiale und
den Rest des Wortes in GroR3druck an.

* Anzahl der Zeichen (Standard: 1): Legt fest, wie viele Zeichen in Initialen umgewandelt
werden sollen. Das Feld ist nicht verfigbar, wenn die unterstehende Option Ganzes Wort
aktiviert ist.
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» Zeilen (Standard: 3): Legt fest, Uber wie viele Zeilen sich die Initiale von der ersten Zeile im
Absatz aus nach unten erstrecken soll. Absatze mit weniger Zeilen kénnen nicht mit Initia-
len versehen werden. Die Auswahl ist auf 2 bis 9 Zeilen beschrankt.

* Abstand zum Text (Standard: 0): Abstand zwischen den Initialen und dem restlichen Text
im Absatz.

* Text: Geben Sie den Text ein, der statt den Anfangsbuchstaben des Absatzes als Initialen
angezeigt werden soll.

* Zeichenvorlage (Standard: Keine): Wahlen Sie die Zeichenvorlage aus, die Sie fur die In-
itialen verwenden mdchten. Uber die Formatvorlagen, die vorher definiert sein miissen,
kénnen Sie das Aussehen der Initialen weiter beeinflussen, wie die Farbe, das Schriftenre-
lief oder andere Schrifteffekte. Um die Formatvorlage des aktuellen Absatzes zu verwen-
den, wahlen Sie im Feld ,,Auswahlliste” den Eintrag ,[keine]" aus.

Hintergrund

Uber diese Seite lasst sich der Hintergrund eines Absatzes festlegen, z. B. fiir Prospekte oder Bro-
schiren. Auch die Hervorhebung durch farbliche Gestaltung oder dekorative Grafikelemente kdn-

nen Sie damit realisieren. Fir den Hintergrund kann wahlweise eine Farbe oder eine Grafik ge-
wahlt werden.

Der Hintergrund wird nur auf den Absatzbereich (Textbereich) angewendet. Wenn Sie einen einge-
rickten Absatz festgelegt haben, wird der Raum zwischen dem Absatz und dem Rand keine Hin-
tergrundfarbe aufweisen.

* Als: Auswabhl, ob der Hintergrund als Farbe oder als Grafik dargestellt wird.

Farbe

Abbildung 23 zeigt die Seite Hintergrund flr die Auswahl Farbe. Die vordefinierten Farben lassen
sich Uber das Menl Extras > Optionen ... > LibreOffice > Farben durch selbstdefinierten Farben
erganzen. Die Hintergrundfarbe ist flr den Hintergrund eines Absatzes definiert. Bei eingezogenen
Abséatzen wird Raum zwischen dem Absatz und dem Rand nicht farblich hinterlegt. Im Feld Fir ha-
ben Sie die Auswahl:

Absatzvorlage: Textkorper &J

|- Verwalten J ElnzugeundAbstande I Ausrichtung Textfl_t_.lss_l__Sghﬂf_t_l Schrifteffekt I Paosition

i Gliederung&l\lummerlerung I Tabulatoren I Initialen | Hintergrund i Umrandung i Bedingung

Als [Farbe [+] Fur f

Hintergrundfarbe

[Keine Fillung |

LL.L
LA
BELLCA
BELLE
BULE
BN
|_|_.|__..

J =0
=5
=2
=

_'I------- .
Abbildung 23: Die Absatzvorlage, Seite Hintergrund, Auswahl Farbe.

* Absatz: Die aus der Farbpalette ausgewahlte Farbe farbt den Hintergrund vom linken bis
zum rechten Seitenrand.

* Zeichen: Die aus der Farbpalette ausgewahlte Farbe farbt nur den Zeichenhintergrund.

Grafik

Abbildung 24 zeigt die Seite Hintergrund mit der Auswahl Grafik. Weitere Informationen zur Ar-
beit mit Grafiken als Hintergrund finden Sie auch in der Dokumentation zu LibreOffice Impress.
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» Durchsuchen: Uber die Schaltflache Durchsuchen wahlen Sie die Datei fiir die Hinter-
grunddatei aus. Nach der Auswahl der Datei erscheint im rechten Vorschaufenster eine
Voransicht der Datei.

* Verkniipfung: Stellt eine Verkniipfung zur Grafikdatei her oder bettet sie in die aktuelle Da-
tei als Hintergrund ein. Das unterstehende Textfeld (unten mit 'unverknipfte Grafik' be-
zeichnet) zeigt den Pfad und Dateinamen der verknlpften Grafikdatei an.

° Art: Hier wird angegeben, wie die Grafik als Hintergrundbild angezeigt werden soll.

0 Position: Wahlen Sie diese Option aus, und klicken Sie auf eine Stelle im Positi-
onsraster.

¢ Flache: Dehnt die Grafik Uber die gesamte Hintergrundflache des ausgewahlten
Objekts aus.

¢ Nebeneinander: Die Hintergrundflache des ausgewahlten Objekts wird durch
mehrmalige Wiederholung der Grafik kachelartig ausgefullt.

Absatzvorlage: Standard Lﬁ
WVerwalten | Einziige und Absténde I Ausrichtung | Textfluss I Scﬂrn"‘t | Schrlf‘te‘!"fekt I Position |
Gliederung & Mummerierung | Tabulatoren | Initialen J Hintergrund I Umrandung

Datei

Durchsuchen... Verknipfung

unverknipfte Grafik
Art

1 Position o 3 =3
) Flache
@ Mebeneinander

(€7 . (73
= o 3 [] verschau
OK ] [ Zuweisen | | Abbrechen [ Hilfe ] I Zurick I l Standard

e

Abbildung 24: Die Absatzvorlage, Seite Hintergrund, Auswahl Grafik.

Umrandung

Mit Umrandungen kdnnen Sie Seiten, Absatze, Texte, Rahmen, Tabellen, Grafiken, besondere Hin-
weise u. a. hervorheben. So werden Umrandungen oftmals als Abgrenzung fur Kopf- und FuRzei-
len vom eigentlichen Text genutzt, wie Sie es auch in der Ful3zeile dieser Dokumentation sehen.
Die farbliche Gestaltung einer Umrandung kann zuséatzlich Elemente dekorativ hervorheben.

Fur die Umrandung konnen Sie die Position, Grol3e, Farbe, Linienart und -breite (Stil) u. a. Eigen-
schaften der Umrandung vorgeben. Achten Sie auch darauf, dass der Abstand zwischen der Um-
randung und dem Absatzbereich durch Einztige und Tabulatoren beeinflusst wird.
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Wenn Sie die Umrandung einer ganzen Tabelle in Ihrem Text &ndern mochten, set-
zen Sie den Cursor in eine Tabellenzelle, nach einem Rechtsklick wahlen aus dem

Tipp Kontextment Tabelle und die Seite Umrandung. Um nur die Umrandung einer Ta-
bellenzelle zu andern, wahlen Sie die Zelle aus, klicken dann mit der rechten
Maustaste und wahlen Tabelle und schlief3lich die Seite Umrandung.

Die Seite Umrandung ist in mehrere Bereiche unterteilt (Abbildung 25):

Absatzvorlage: Standard L&
Werwalten Einzige und Abstinde I Ausrichtung | Textfluss I Schrift | Schrifte‘f'fekt_l Position
Gliederung & Nurnmerierung | Tabulatoren | Initialen | Hintergrund i Umrandung
Linienanordnung Linie Abstand zum Inhalt
Standard stil Links 0,00 em |5
I o |— IZ| Rechts 0,00 cm 5
Benutzerdefiniert Ereite Oben a0 cm 2
0,05 pt =
Earbe 5
Sync
|- Schwarz Izl =
Schatten
Position Farbe
i_l I { |- Grau B
Eigenschaften
[¥] Mit dem nichsten Absatz verschmelzen
[ 0K ] [ Zuweisen | | Abbrechen ] [ Hilfe ] I Zuriick l l Standard
Abbildung 25: Die Absatzvorlage, Seite Umrandung.

Bereich Linienanordnung:

* Standard: Hier kbnnen Sie aus mehrere vordefinierte Standardumrandungen wahlen. Die
dunklen Linien innerhalb eines Symbols zeigen die Linien an, die in dem gewéahlten Stil und
in der gewahlten Farbe eingefligt werden.

* Benutzerdefiniert: Hier wird die Auswahl, die mit Standard getroffen wurde, als Vorschau
angezeigt. Zusatzlich kdnnen Sie auch durch Klicken auf die Linienbereiche (durch kurze
graue Linien angedeutet) einzelne Linien hinzufiigen oder entfernen. Die Vorschau zeigt
die Linien in drei unterschiedlichen Zustanden an (Abbildung 26):

° Schwarze Linie: Die Linie wird an der ausgewahlten Position eingefugt (Abbildung
26 a).

° Graue Linie: An dieser Position kann keine Linie hinzugefugt oder entfernt werden
(Abbildung 26 b).

° Weil3e Linie: An dieser Position wird die Linie entfernt (Abbildung 26 c).
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a) b) C)
Abbildung 26: Benutzerdefinierte Linienanordnung: a) Linie wird ein-

gefligt, b) Linie kann nicht gedndert werden und c) Linie wird ent-
fernt.

Bereich Linie:

Notiz

Stil: Wahlen Sie aus dem Auswabhlliste die Linienart aus.
Breite: Legen Sie die Breite der ausgewahlten Linien fest.
Farbe: Weisen Sie einer oder mehreren Linien eine Farbe zu.

Das starkere Attribut hat stets Vorrang vor dem schwécheren Attribut. Beispiel:
Eine Zelle einer Tabelle besitzt eine 2 Punkt breite rote Umrandung und die be-
nachbarte Zelle eine blaue 3 Punkt breite Umrandung. In diesem Fall ist die ge-
meinsame Grenze zwischen beiden Zellen blau und 3 Punkt breit.

Bereich Abstand zum Inhalt: Geben Sie an, wie viel Freiraum zwischen dem Rand und dem Inhalt
der Auswahl (dem Text) bleiben soll.

Links (Standard: 0,05 cm): Abstand zwischen dem linken Rand und dem Inhalt der Aus-
wahl.

Rechts (Standard: 0,05 cm): Abstand zwischen dem rechten Rand und dem Inhalt.
Oben (Standard: 0,05 cm): Abstand zwischen dem oberen Rand und dem Inhalt.
Unten (Standard: 0,05 cm): Abstand zwischen dem unteren Rand und dem Inhalt.

Synchronisieren (Standard: Aktiviert): Zu allen vier Randern wird der gleiche Abstand ein-
gestellt. Nur in einem Feld kann der Abstand eingegeben werden.

Bereich Schatten: Sie kdnnen einer Umrandung auch einen Schatteneffekt zuweisen. Am besten
wirkt dieser Effekt, wenn alle vier Rander sichtbar sind.

Notiz

Position: Hier legen Sie die Position des Schattenwurfs fest. Der Standard ist kein Schat-
tenwurf.

Distanz (nur verfligbar, wenn ein Schattenwurf ausgewahlt wurde): Gibt die Schattenbreite
incm an.

Farbe (nur verfiigbar, wenn ein Schattenwurf ausgewahlt wurde): Auswahl der Farbe des
Schattens.

In einem Textrahmen verankerte Grafiken oder Objekte in einem Dokument sind
auf die Grole dieses Textrahmens begrenzt. Wenn Sie auf die Rander eines Ob-
jekts, das einen ganzen Textrahmen ausflllt, einen Schatteneffekt anwenden, wird
das Objekt so weit verkleinert, dass auch der Schatten im Rahmen Platz findet.

Bereich Eigenschaften:

Mit dem ndchsten Absatz verschmelzen (Standard: Aktiviert): Verschmilzt die Umran-

dungs- und die Schattierungsvorlage des aktuellen Absatzes mit den Vorlagen des nachs-
ten Absatzes. Diese Vorlagen werden nur dann verschmolzen, wenn die Vorlagen fur Ein-
zug, Umrandung und Schattierung fir den aktuellen und den nachsten Absatz gleich sind.
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Arbeiten mit bedingten Absatzvorlagen

Durch die Zuweisung einer bedingten Absatzvorlage zu einem Dokument ist es mdglich, den ein-
zelnen Elementen (Kontext) Ihres Dokuments, wie Tabellen, Rahmen, Kopfzeile, Ful3zeile oder
Gliederungsebene, jeweils eigene Formatierungen zuzuweisen. Die den Elementen zugewiesenen
Absatzvorlagen kénnen auch eigene, vorher definierte Vorlagen sein. Die bedingte Absatzvorlage
fungiert sozusagen als tbergeordnete Vorlage und ermdglicht die einheitliche Gestaltung von Do-
kumenten, z. B. eines Geschaftsbriefes. Die Formatierungen fiir den eigentlichen Text erfolgt auf
den Seiten der bedingten Absatzvorlage. Werden den Elementen Ihres Dokuments keine Vorlagen
zugeordnet, so werden die Formatierungen der bedingten Vorlage verwendet.

Achtung Eine Absatzvorlage kann nur bei erstmaligen Erstellung als bedingte Absatzvor-
A lage definiert werden. Nach dem SchlieRen Uber die Schaltflache OK ist die Seite
Bedingung nicht mehr sichtbar und zugénglich.

Ein Beispiel soll das Vorgehen und die Auswirkungen verdeutlichen:

1) Offnen Sie ein leeres Textdokument und schreiben Sie einen kurzen Text als Geschéfts-
brief mit einer Kopf- und Ful3zeile (Format > Seite > Kopfzeile bzw. Format > Seite >
FuBzeile).

2) In der Absatzvorlage Kopfzeile stellen Sie den Hintergrund auf die Farbe blau.
3) In der Absatzvorlage FuBBzeile stellen Sie den Hintergrund auf die Farbe rot.

4) Definieren Sie eine neue Absatzvorlage, indem Sie aus dem Kontextmeni des Fensters
Formatvorlagen den Befehl Neu... wéhlen und im Dialogfenster der Absatzvorlage alle Ab-
satzeigenschaften festlegen, die Sie in Ihrem Geschaftsbrief fiir normale Absatze bevorzu-
gen. Geben Sie dieser Vorlage auf der Seite Verwalten den Namen "Geschéaftsbrief". Ach-
tung! Bestatigen Sie nicht mit OK.

5) Wechseln Sie auf die Seite Bedingung, und markieren Sie das Feld Als bedingte Vor-
lage, um die neue Absatzvorlage als bedingte Vorlage zu definieren (Abbildung 27).

6) Unter Inhalt wahlen Sie nun den Eintrag Kopfzeile und im Listenfeld Absatzvorlagen die
Vorlage, die fur die Kopfzeile in lhrem Geschaftsbrief gelten soll, also z. B. die vorgegebe-
ne Absatzvorlage Kopfzeile (Abbildung 27). Nattrlich kbnnen Sie hier auch eine vorher
selbstdefinierte Vorlage auswéhlen.

7) Unter Inhalt wéahlen Sie nun den Eintrag FuBzeile und im Listenfeld Absatzvorlagen die
Vorlage, die fur die Fu3zeile in Threm Geschaftsbrief gelten soll, also z. B. die vorgegebene
Absatzvorlage FuBzeile (Abbildung 27). Nattrlich kdnnen Sie hier auch eine vorher selbst-
definierte Vorlage auswahlen.

8) Durch einen Klick auf die Schaltflache Zuweisen oder durch Doppelklick auf den Eintrag
im Listenfeld Absatzvorlagen, ordnen Sie die Vorlage dem Kontext zu (Abbildung 27).

9) SchlieRen Sie das Dialogfenster Absatzvorlagen mit OK, und formatieren Sie alle Abséatze
Ihres Geschéftsbriefs, einschliel3lich der Kopf- und Ful3zeile, mit der neuen bedingten Ab-
satzvorlage "Geschéftsbrief". (Wenn Sie in die Kopf-/Ful3zeile klicken, kann es gegebenen-
falls nétig sein, sich alle Vorlagen oder die Benutzervorlagen im Fenster Formatvorlagen
anzeigen zu lassen, um die neue Vorlage "Geschéftsbrief* anwenden zu kdénnen.)

10) Die Kopf-/FuRRzeile sollte jetzt blau/rot dargestellt werden.
Auf der Seite Bedingung finden Sie weitere Bedienelemente:

* Bedingte Vorlage (Standard: Nicht aktiviert): Mit der Aktivierung dieser Option definieren
Sie die neue Vorlage als bedingte Vorlage.

* Inhalt: Vordefinierte Elemente (Kontext) ihres Dokuments, denen Sie Absatzvorlagen zu-
ordnen konnen.

* Verwendete Vorlagen: Auflistung aller einem Kontext zugewiesenen Absatzvorlagen.

Arbeiten mit bedingten Absatzvorlagen 28



Absatzvorlagen: Auflistung aller Absatzvorlagen, die Sie einem Kontext zuordnen kénnen.
Vorlagengruppen: Die Formatvorlagen sind den Vorlagengruppen zugeordnet.

Name Bedeutung
Automatisch Anzeige der zum aktuellen Kontext passenden Vorlagen.
Alle Vorlagen Zeigt alle Vorlagen des aktuellen Vorlagentyps.

Verwendete Vorlagen

Zeigt die Formatvorlagen (aus der ausgewahlten Kategorie) an, die
im aktuellen Dokument verwendet werden.

Benutzervorlagen Zeigt die vom Benutzer definierten Vorlagen des aktuellen Vorl-
agentyps.

Zeichenvorlagen Zeigt die Formatvorlagen fur Text an.

Kapitelvorlagen Zeigt die Formatvorlagen fiir Uberschriften an.

Listenvorlagen Zeigt die Formatvorlagen fir nummerierte Listen oder Listen mit

Aufzahlungszeichen an.

Verzeichnisvorlagen

Zeigt die Formatvorlagen fiir Verzeichnisse an.

Vorlagen Sonderbe-
reiche

Zeigt die Formatvorlagen fur Kopf- und Fuf3zeilen, Ful3- und End-
noten, Tabellen und Beschriftungstext an.

HTML-Vorlagen

Zeigt die Vorlagen fir HTML-Dokumente.

Bedingte Vorlagen

Zeigt die von lhnen definierten bedingten Vorlagen.

Hierarchisch

Zeigt die Vorlagen der ausgewahlten Kategorie in einer hierarchi-
schen Liste an. Um die Vorlagen einer Unterebene anzuzeigen, kli-
cken Sie auf das Pluszeichen (+) neben dem Namen der betreffen-
den Unterebene.

-

Absatzvorlage: Unbenanntl

=

Verwalten | Einzige und Abstdnde | Ausrichtung | Textfluss | Schrift I Schrifteffekt I Position

1. Ebene Gliederung
. Ebene Gliederung
. Ebene Gliederung
. Ebene Gliederung
. Ebene Gliederung
. Ebene Gliederung
. Ebene Gliederung

Fhene Gliederunn

00 =] Tholn B Ll Ba

Gliederung & Mummerierung Tabulatoren Initialen Hintergrund | Umrandung | Bedingung
Optionen

[¥] Bedingte Vorlage

Inhalt Verwendete Vorlagen Absatzvorlagen

Tabellenkopf « | |Empfanger -
Tabelle || |Endnote

Rahmen Fulinote

Bereich
Rl anic =l [FuBzeile links B
Endnote =

Kopfzeilen Kaopfzeile
FuBzeile FuBzeile

FuBzeile rechts
Gegeniberstellung
—| |GruBformel
Herizontale Linie
Inhaltsverzeichnis 1
Inhaltsverzeichnis 2
Inhaltsverzeichnis 3
Inhaltsverzeichnis 4 -

- |Alle‘ur0r|agen El

Zuweisen

Entfernen

OK l ’ Zuweisen

[ Abbrechen

[ Hilfe H Zurick H Standard ]

|

Abbildung 27: Die Absatzvorlage, Seite Bedingung.
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* Entfernen: Klicken Sie hier, um die aktuell markierte Zuweisung von Kontext und verwen-
deter Vorlage zu entfernen.

* Zuweisen: Klicken Sie auf die Schaltflache, um die ausgewéhlte Absatzvorlage als ver-
wendete Vorlage dem zuvor ausgewahlten Kontext zuzuweisen.

Zeichenvorlagen

Mit Hilfe von Zeichenvorlagen werden die Formatierungsmaglichkeiten innerhalb eines Absatzes
erweitert. Die Zeichenvorlagen werden auf einzelne oder mehrere Zeichen, Worter oder Satze an-
gewandt, aber gewdhnlicherweise nicht auf den ganzen Absatz. Beispielsweise lassen sich damit
Zeichen oder Worter kursiv, fett oder farbig hervorheben.

In diesem Dokument werden u. a. die Zeichenvorlagen verwendet:

* LibOTaste: Eine Zeichenvorlage aus der Vorlagengruppe 'Benutzervorlagen’, die die mar-
kierten Zeichen/Wadrter kursiv stellt.
Beispieltext mit angewandter Zeichenvorlage: Dricken Sie die Tastenkombination Um-
schalt+Strg+J.

* LibOMeniiPfad: Eine Zeichenvorlage aus der Vorlagengruppe 'Benutzervorlagen', die die
markierten Zeichen/Wérter fett darstellt.
Beispieltext mit angewandter Zeichenvorlage: Diese Einstellung kdnnen Sie tber das Menu
Extras > Optionen > LibreOffice > Farben andern.

Weitere Anwendungsmadglichkeiten werden an verschiedenen Stellen des Writer Handbuches be-
schrieben, z. B. bei der Kapitel-, Seiten- oder Listennummerierung, der Hervorhebung von Hyper-
links.

Die Verwendung von Woértern aus anderen Sprachen oder von Programmiersprachen wird Writer
diese bei eingeschalteter Rechtschreibprifung (s. Absatzvorlagen, Textfluss, S. 13) als fehlerhaft
markieren. Um das zu vermeiden, definieren Sie eine Zeichenvorlage, legen die zutreffende Spra-
che fest und ordnen Sie diese Vorlage den Wértern zu.

Vorteile von Zeichenvorlagen

Viele Anwender von Writer fragen sich ,Warum soll ich Zeichenvorlagen verwenden?" oder ,Was
unterscheidet Zeichenvorlagen vom Klicken auf das Icon fir Fettschrift?* Ein kleines Beispiel soll
das erlautern:

Michaela schreibt ein Buch und lernt dabei die Vorteile der Zeichenvorlagen kennen.
Das fertige Manuskript schickt sie zum Verleger, der von ihre aber verlangt, dass die
in ihrem 200-seitigen Text vorkommenden Mentipfade nicht fett gedruckt werden
sollen. Da sie keine Zeichenvorlage dafiir benutzt hat, muss sie alle 200 Seiten per
Hand mittels Suchen & Ersetzen editieren. Das war das letzte Mal, dass sie keine
Zeichenvorlagen benutzt hat.

Die Vorteile der Zeichenvorlagen sind u. a.:

+ Formatierungsidnderungen: Wie das obige Beispiel zeigt, konnen Anderungen fir das ge-
samte Dokument erfolgen.

« Konsistente Anderungen: Die Anderungen sind im ganzen Dokument gleich und es las-
sen sich einheitliche Formatierungsrichtlinien erstellen.

* Konzentration auf den Inhalt: Der Autor muss nicht jedes Mal neu dartiber nachdenken,
wie z. B. Menupfade oder Tastaturkirzel hervorgehoben werden sollen. Eine entsprechen-
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de Bezeichnung der Vorlage erleichtert die Arbeit und befreit den Autor von aufwandigen
Formatierungsarbeiten.

Eine neue Zeichenvorlage erstellen

In diesem Abschnitt werden die Erstellung einer neuen Zeichenvorlage und die Einstellméglichkei-
ten auf den Registerseiten der Zeichenformatvorlage beschrieben. Viele der Seiten wurden schon
in Zusammenhang mit den Absatzvorlagen (s. Absatzvorlagen ab S. 9) behandelt. Wahrend die
Seiten Schrift (s. Abschnitt Schrift, S. 15), Schrifteffekte (s. Abschnitt Schrifteffekt, S. 17) und Po-
sition (s. Abschnitt Position, S. 18) identisch sind, unterscheiden sich die Seiten Hintergrund (s.
Abschnitt Hintergrund, S. 24) und Umrandung (Umrandung, S. 25) ein wenig:

* Hintergrund: Hier kdnnen Sie nur eine Hintergrundfarbe auswéahlen. Die Auswahl als
Grafik ist fur ein Zeichen nicht sinnvoll.

* Umrandung: Das Optionsfeld Mit dem nachsten Absatz verschmelzen ist nicht vorhan-
den und fur ein Zeichen auch nicht sinnvoll.

An dieser Stelle wird daher nur die Erstellung einer Zeichenformatvorlage erlautert:

« Offnen Sie das Fenster Formatvorlagen (iiber die Funktionstaste F11, das Menii Format >
Formatvorlagen oder das Symbol |-Z] oder ©).

* Wahlen Sie die Zeichenvorlagen und daraus eine Vorlage, die als Grundlage fir Ihre neue
Zeichenvorlage dienen soll, z. B. Standard. Mit der rechten Maustaste 6ffnen Sie das Kon-
textmend und wahlen Neu.

« Im sich 6ffnenden Dialogfenster Zeichenvorlage konnen Sie auf den einzelnen Seiten An-
derungen an den Einstellungen vornehmen.

* Auf der Seite Verwalten geben Sie der Vorlage eine aussagekraftige Bezeichnung, die bei-
spielsweise die Verwendung beschreibt, wie etwa MeniiPfad.

« Uber die Seite Schrift andern Sie den Schriftsatz, die Schriftart und deren GréRe, die so-
wohl als Absolutwert in pt oder einer LaAngeneinheit (mm, Zoll) als auch in Prozent angege-
ben werden kann. Im Abschnitt Relative SchriftgréRe auf der Seite 16 dieses Handbuches
finden Sie dazu weitergehende Informationen und Beispiele. Sie kénnen hier auch die
Sprache fir einzelne Worter oder Zeichen festlegen, so dass sie von der entsprechenden
Rechtschreibprifung erkannt und nicht als falsch geschrieben angezeigt werden.

* Die Seite Schrifteffekte enthalt verschiedene Schriftauszeichnungen, die Sie fiir einzelne
Wérter oder Zeichen verwenden kénnen, wie Schriftfarbe, Uber-, Unter- oder Durchstrei-
chungen, Konturen, Reliefs, Kapitalchen, verborgene Schrift u.a.

* Einstellungen auf der Seite Position legen die Position (Hoch-/Tiefstellung), Skalierung,
Rotation und Laufweite von Zeichen fest.

* Zum Schluss kdnnen Sie noch auf der Seite Hintergrund einen farblichen Hintergrund fur
die ausgewahlten Zeichen oder Woérter festlegen, sowie Gber das Register Umrandung
den Text mit linienartigen Abgrenzungen hervorheben.

Zeichenvorlagen statt manueller Formatierung

Viele Anwender von Writer formatieren ihren Text manuell Giber die Symbolleiste. Die Vorteile einer
schnellen und durchgangigen Anderung durch Formatvorlagen wurden bereits erlautert (s. Ab-
schnitt ,Vorteile von Zeichenvorlagen", S. 30). Dazu einige Hinweise zum einfacheren Ubergang
von der manuellen Formatierung zur Verwendung von Formatvorlagen:

* Mischen Sie keine Zeichenvorlagen und manuelle Formatierung: Die manuelle Forma-
tierung Uberschreibt die Zeichenvorlagen. Wenn Sie beide vermischen kann das zu uner-
wunschten Formatierungen fiihren (Formatierungsdschungel) und Sie verschwenden viel
Zeit, um herauszufinden, warum lhre Zeichenvorlage nicht funktioniert.
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* Entfernen Sie die manuelle Formatierung: Mit einem Rechtsklick auf die ausgewahlten
Zeichen oder Worter wahlen Sie aus dem Kontextmen( Direkte Formatierung entfernen
oder Uber das Meniu Format > Direkte Formatierung entfernen oder tiber die Tastenkom-
bination Strg+M. Damit werden alle manuellen Formatierungen, die Sie Uber das Menu
oder die Symbolleiste durchgefihrt haben, entfernt, nicht aber die Formatvorlagen. Um
auch die Zeichenformatierung Gber Formatvorlagen zu entfernen, weisen Sie den markier-
ten Zeichen oder Wortern die Zeichenformatvorlage Standard zu.

* Lassen Sie das Fenster Formatvorlagen (tUber die Funktionstaste F11, das Menl Format >
Formatvorlagen oder das Symbol |2 oder © in der Symbolleiste Format zu erreichen) of-
fen oder docken Sie es an den rechten oder linken Rand, dann kénnen Sie schnell und ein-
fach auf die Formatvorlagen zugreifen.

« Ubernehmen Sie bereits erstellte und im aktuellen Dokument wiederzuverwendende For-
matvorlagen aus anderen Dokumenten.

* Ein Doppelklick auf eine vorhandene Formatvorlage im offenen Formatvorlagenfenster ist
genauso einfach, wie ein Klick auf ein Symbol in der Symbolleiste, z.B. um markierte Zei-
chen oder Worter fett darzustellen.

Rahmenvorlagen

Rahmen werden oft als Container fur Text oder Grafik verwendet. Die Verwendung von Rahmen-
vorlagen erméglicht Ihnen, das Layout, die Position, den Abstand der Rahmenbegrenzung zum ei-
gentlichen Inhalt und weitere Formatierungen festzulegen, um ein einheitliches Erscheinen ihres
Dokumentes zu erreichen. Wenn Sie Fotos mit einem dekorativen Rand versehen wollen, so plat-
zieren Sie das Foto in einen Rahmen und kénnen den Rahmen entsprechend lhren Vorstellungen
gestalten. Dieser Rahmen lasst sich Uber die gesamte Seite verschieben, auch Uber den Seiten-
rand hinaus. Bei einer Fotosammlung soll dieser Rahmen sicherlich fur weitere Fotos verwendet
werden. Dafir ist es vorteilhaft eine Rahmenvorlage zu verwenden. Diese kann dann den gestalte-
ten Rahmen beinhalten und in der GroR3e variabel sein.

Writer bietet Ihnen schon einige vordefinierte Rahmenvorlagen an, die Sie modifizieren kénnen
oder Sie erstellen sich bei Bedarf neue Rahmenvorlagen. Neue Rahmenvorlagen sind ahnlich zu
erstellen, wie Absatz- oder Zeichenvorlagen.

Bei der Seitenformatierung konnen Rahmen und Bereichen verwendet werden.
Tipp Zwischen beiden gibt es einige Uberschneidungen. In Kapitel 4 ,Seitenformatie-
rung” kdnnen Sie sich dariber informieren.

Besonderheiten von Rahmenvorlagen

Beim Einfligen von Objekten in Writer werden diese automatisch mit einem vordefinierten Rahmen
versehen, dabei wird auch die Position ermittelt und die Beziehung zu anderen Elementen des Do-
kumentes berlcksichtigt. Nach der Einbettung des Objektes kénnen Sie die Eigenschaften des
Rahmens modifizieren.

Weil Objekt und Rahmen gleichzeitig erstellt werden, ist es manchmal einfacher, beide als Einheit
zu betrachten. In anderen Fallen, z. B. bei Diagrammen, kann es sinnvoll sein, Rahmen und Objekt
separat bearbeiten zu kénnen.

Im Gegensatz zu anderen Formatvorlagen, wie Absatz- oder Zeichenvorlagen, kénnen in Rahmen-
vorlagen nicht alle Eigenschaften vorher definiert werden. So kdnnen beispielsweise die Veranke-

rungen des Rahmens, die Anordnung gegeniber anderen Objekten oder die Anordnung zum Text

im Dokument erst nach der Erstellung festgelegt werden. Zudem sind diese Einstellungen nur ma-
nuell und fir jeden Rahmen einzeln durchzufihren.
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Sie kénnen Uber das Menu Einfliigen > Rahmen einen Rahmen neu erstellen und im sich 6ffnen-
den Dialogfenster die gewiinschten Einstellungen fur jeden Rahmen vornehmen. Wie bei den an-
deren Vorlagen auch ist aber der Weg Uber das Formatvorlagenfenster und die Zuweisung zu ei-
ner bereits erstellten Rahmenvorlage die einfachste und effektivste Methode die Rahmen zu for-
matieren.

Standard-Rahmenformatvorlagen

Wenn Sie mehrere Grafiken in Ihr Dokument einbinden mdchten, kénnen Sie verschiedene Rah-
menvorlagen definieren: mit unterschiedlichen Rahmenbegrenzung oder Farbhintergriinden sowie
eine weitere Rahmenvorlage nur flr den Text.

Andererseits stellt hnen Writer, die in Tabelle 1 aufgelisteten, vordefinierten Rahmenvorlagen zur
Verfugung, die fur eine Vielzahl von Aufgaben ausreichend sind. Oftmals reicht es, den Rahmen zu
gestalten oder bei oftmaliger Verwendung aus den vordefinierten Rahmenvorlagen eigene zu er-
stellen.

Tabelle 1. Rahmenvorlagen und ihre Verwendung

Rahmenvorlage Verwendung und Kommentar

Etiketten Die Rahmenvorlage wird von LibreOffice fur Etiketten (Meni: Datei > Neu >
Etiketten) verwendet und ist nicht zur Verwendung durch den Benutzer ge-
dacht. Der Inhalt, die Position und Grof3e des Rahmens sind geschitzt. Die
Verankerung erfolgt "Am Zeichen".

Formel Die Rahmenvorlage wird fir Formeln verwendet. Der Rahmen wird horizontal
links ausgerichtet und am Zeichen verankert.

Grafik Die Rahmenvorlage wird vorzugsweise fir Grafiken verwendet. Der Rahmen
wird horizontal mittig ausgerichtet und am Absatz verankert. Zwischen dem
Inhalt und der Umrandung ist kein Abstand festgelegt.

Marginalie Rahmenvorlage fir Marginalien. Der Rahmen ist fiir Kommentare, Korrektu-
ren oder Bemerkungen auf dem Rand vorgesehen. Der Rahmen wird links,
am Anfang des Absatzes platziert und am Absatz verankert. Zwischen dem In-
halt und der Umrandung ist kein Abstand festgelegt.

OLE Rahmenvorlage fiir OLE-Objekte. Der Rahmen wird horizontal zentriert und
vertikal nach oben ausgerichtet. Die Verankerung erfolgt "Am Absatz". Zwi-
schen Inhalt und Umrandung ist kein Abstand festgelegt.

Rahmen Das ist die Standard-Rahmenvorlage. Der Rahmen wird horizontal mittig aus-
gerichtet und am Absatz verankert. Zwischen dem Inhalt und der Umrandung
ist ein Abstand festgelegt und der Rahmen wird durch eine Umrandung be-
grenzt.

Wasserzeichen Die Rahmenvorlage fir Wasserzeichen, z. B. fur ein Hintergrundbild oder
einen Text. Das Wasserzeichen sollte schwach, aber noch lesbar sein und in
der Anordnung unter dem eigentlichen, gut lesbaren Text liegen. Der Rahmen
wird horizontal und vertikal mittig ausgerichtet und an der Seite verankert.

Standardmafiig verwenden alle Rahmenvorlagen die Absatzvorlage Rahmeninhalt und die Zei-
chenvorlage Standard. Die Eigenschaft Automatische GréRe ist nur fur die Hohe aktiviert, da-
durch passt sich die Grofie (Hohe) des Rahmens an die Hohe des Inhalts (Text, Formel, Grafik)
an. Wird die Formel im Formeleditor geschrieben, wird sowohl die Hohe, als auch die Breite des
Rahmens an die Formel automatisch angepasst. Sie sollten bei der Erstellung eines Rahmens
auch fur die Breite die Eigenschaft Automatische GroRe auf aktiviert setzen.
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Eine nheue Rahmenvorlage erstellen

Analog der bereits beschriebenen Vorgehensweise zur Erstellung von Formatvorlagen, konnen Sie
auch Rahmenvorlagen erzeugen:

« Offnen Sie das Fenster Formatvorlagen (iiber die Funktionstaste F11, das Menii Format >
Formatvorlagen oder das Symbol | oder ©).

* Wahlen Sie die Rahmenvorlagen und daraus eine Vorlage, die als Grundlage fur lhre neue
Rahmenvorlage dienen soll, z. B. Mein Rahmen. Mit der rechten Maustaste 6ffnen Sie das
Kontextmenu und wahlen Neu.

« Im sich 6ffnenden Dialogfenster Rahmenvorlage konnen Sie auf den einzelnen Seiten An-
derungen an den Einstellungen vornehmen und die Rahmenvorlage lhren Bedirfnissen an-
passen. Achten Sie darauf, dass die Vorgaben nicht zu starr sind, damit die Rahmenvor-
lage auch fir ahnliche Objekte verwendbar bleibt.

Verwalten

Auf der Seite Verwalten (Abbildung 28) kénnen Sie allgemeine Angaben zur neu erstellten Rah-
menvorlage machen.

=
Rahmenvorlage: Rahmen &J

WYerwalten [I:}!r_pEOpti:}nenEUmIaufEHintergrundEUmrandun_gliSpalteniM;c;-i
Formatvorlage
Mame Rahmen [[TAutematisch aktualisieren:
Verkndpfen mit | Keine - |Z|
Enthalt
Einzug links 0,2 cm, Einzug rechts 0,2 cm + Von oben 0,2 cm, Von unten 0,2 cm + paralleler Umlauf + cben
+ horizontal zentriert + Am Absatz + Urnrandung (Schwarz, Einfach, durchgehend), Abstand 0,15 cm

Abbildung 28: Die Rahmenvorlage, Seite Verwaltung.

* Name: Geben Sie der Formatvorlage eine aussagekréftige Bezeichnung, die beispielswei-
se die Verwendung beschreibt, wie etwa Rahmen, breiter Rand.

« Automatisch aktualisieren (Standard: Nicht aktiviert): Bei aktivierter Option werden Ande-
rungen durch direkte Formatierung in die entsprechende Formatvorlage geschrieben und
alle tbrigen Rahmen im Dokument, die ebenfalls auf dieser Formatvorlage beruhen, wer-
den automatisch angepasst.

Achtung Wenn Sie gewdhnlich die direkte (manuelle) Formatierung verwenden, vergewis-
sern Sie sich, dass die Option Automatisch aktualisieren nicht aktiviert ist, an-
dernfalls kénnen Teile des Dokuments unerwartet neu formatiert sein.

* Verkniipft mit: Beim Erstellen einer neuen Formatvorlage:

° wird die neue Formatvorlage mit der Formatvorlage verkniipft, die Sie Gber
Rechtsklick ausgewéhlt haben, um diese neue Formatvorlage zu erstellen.

° wird der Name der Uber Rechtsklick ausgewahlten Formatvorlage in das Feld Ver-
kniipft mit eingetragen.

° werden die Eigenschaften der Uber Rechtsklick ausgewahlten Formatvorlage in die
neue Formatvorlage tbernommen.
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Typ

Bereich: Hier legen Sie fest, in welchem Bereich die Formatvorlage sichtbar ist. Flr selbst-
erstellte Vorlagen bietet sich der Bereich Benutzervorlagen an. Den Bereich kénnen Sie im
Formatvorlagenfenster unterhalb der Vorlage filtern.

Enthalt: Zeigt eine Zusammenfassung der Eigenschaften der Formatvorlage.

Uber die Seite Typ (Abbildung 29) bestimmen Sie die GroRRe und die Position des Rahmens auf
der Seite. Im Vorschaufeld (rechts oben) sehen Sie, wie sich die Einstellungen auswirken.

F -
Rahmenvorlage: Rahmen ﬁ

|‘u‘emra|ten|T}f|ﬂ |Optior|er||Um|aquHintergrundIUmrandungISpaItenIMakro|

Grobe
Breite 0,34 cm 5

[ Relativ zu |—i:£at:'r:E|'Ei-_'h |

I
I

[7] Autematisch

Héahe (mindestens) 0,34 cm =

[ Relativzu |Absatzbereich

[¥] Autematisch
Sertenverhiltnis beibehalten

Position

Haorizontal ﬂ um (0,00 cm ~ zu |Ahsatztextbereich Izl

[T] Auf geraden Seiten spiegeln

Vertikal um (0,00 cm ~| zu |Absatztextbereich
| ]

[T] Textfluss folgen

[ OK l [ Luweisen l Hilfe ] I Zuriick l [ Standard

I Abbrechen

%

Abbildung 29: Die Rahmenvorlage, Seite Typ.

Bereich GréRle:

Breite (Standard: 0,34 cm): Breite des Rahmens. Wenn die Option Automatisch ausge-
wabhlt ist, ist der angegebene Wert die Mindestbreite des Rahmens. Sie sollten flir die Brei-
te einen gréfReren Wert zuweisen oder auch die Option Automatisch aktivieren.

Relativ zu (Standard: Nicht aktiviert): Berechnet die Breite des Rahmens in Prozent an-
hand der Breite der Seite mit Rand (Relativ zu: Absatzbereich) oder ohne Rand (Relativ
zu: Gesamte Seite).

Automatisch (Standard: Nicht aktiviert): Passt die Breite des Rahmens automatisch an
den Inhalt an.

Hohe (mindestens) (Standard: 0,34 cm): Ho6he des Rahmens. Wenn die Option Automa-
tisch ausgewabhlt ist, ist der angegebene Wert die Mindesthéhe des Rahmens.

Relativ zu (Standard: Nicht aktiviert): Berechnet die Hohe des Rahmens in Prozent an-
hand der Hohe der Seite mit Rand (Relativ zu: Absatzbereich) oder ohne Rand (Relativ
zu: Gesamte Seite).

Automatisch (Standard: Aktiviert): Passt die Hohe des Rahmens automatisch an den In-
halt an.
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Seitenverhdltnis beibehalten (Standard: Nicht aktiviert): Behalt das Verhaltnis von Hohe
und Breite bei, wenn Sie eine der beiden Gro3en andern.

Bereich Position:

Horizontal (Standard: Mitte): Richtet den Rahmen horizontal auf der Seite aus. Diese Opti-
on ist nicht verfligbar, wenn fur die Verankerung des Rahmens "Als Zeichen" gewahlt wur-
de.

um (Standard: 0,00 cm): Das Feld ist nur verfiigbar, wenn im Feld Horizontal die Auswahl
"Von Links" getroffen wurde. Der Wert gibt den horizontalen Abstand zwischen dem linken
Rand des Rahmens und den im Feld Zu ausgewahlten Bezugspunkt an.

zu (Standard: Absatztextbereich): Bezugspunkt fur die horizontale Ausrichtung des Rah-
mens.

Auf geraden Seiten spiegeln (Standard: Nicht aktiviert): Spiegelt die aktuellen Einstellun-
gen fur die horizontale Ausrichtung auf geraden Seiten.

Vertikal (Standard: Oben): Richtet den Rahmen vertikal auf der Seite aus. Diese Option ist
nicht verfiigbar, wenn fir die Verankerung des Rahmens "Als Zeichen" gewahit wurde.

um (Standard: 0,00 cm): Das Feld ist nur verfligbar, wenn im Feld Vertikal die Auswahl
"Von Oben" oder bei einer Verankerung "Als Zeichen" die Auswahl "Von Unten" getroffen
wurde. Der Wert gibt den vertikalen Abstand zwischen dem oberen Rand des Rahmens
und den im Feld Zu ausgewahlten Bezugspunkt an.

zu (Standard: Absatztextbereich): Bezugspunkt fur die vertikale Ausrichtung des Rahmens.

Textfluss folgen (Standard: Nicht aktiviert): Der Rahmen wird innerhalb der Layout-Gren-
zen des Textes gehalten, mit dem es verankert ist. Mdchten Sie den Rahmen beliebig im
Text positionieren, so darf diese Option nicht aktiviert sein.

Die Option Textfluss folgen ist standardmaflig aktiviert, wenn Sie ein Dokument 6ffnen,
das mit einer Version von Writer alter als OpenOffice 2.0 erstellt wurde. Diese Option ist je-
doch nicht beim Erstellen bzw. Offnen von Dokumenten im Microsoft Word-Format (*.doc)
aktiviert.

Optionen

Auf der Seite Optionen (Abbildung 30) nehmen Sie Einstellungen zum Schutz des ausgewéahlten
Rahmens und dessen Inhalt fest.

Rahmenvorlage: Rahmen &J

Verwalten[Typ| Optionen [Umlauf [Hintergrund [Umrandung [spaten [Makro]

|
Schiitzen Inhaltsausrichtung

It Wertikale Ausrichtung  |Oben : |

Eigenschaften
[ Editierbar in schreibgeschitztern Dokurnent
[¥] Drucken
Textfluss: !Einstellungen des dbergecrdneten Objekts verwenden El

Abbildung 30: Die Rahmenvorlage, Seite Optionen.

Bereich Schiitzen: Legt die Schutzoptionen fir den Rahmen fest.

Inhalt (Standard: Nicht aktiviert): Der Inhalt des Rahmens wird vor Anderungen geschiitzt.
Der Inhalt kann noch kopiert werden.
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« Position (Standard: Nicht aktiviert): Die Position des Rahmens wird vor Anderungen ge-
schitzt.

« GroRe (Standard: Nicht aktiviert): Schiitzt die GroRe des gewahlten Objekts vor Anderun-
gen.

Bereich Eigenschaften: In diesem Bereich finden Sie die Optionen, die den Rahmen vor ungewoll-
ten Veranderungen schitzen.

» Editierbar in schreibgeschiitztem Dokument (Standard: Nicht aktiviert): Erlaubt das Be-
arbeiten des Inhalts eines Rahmens auch dann, wenn das Dokument schreibgeschutzt ist.

* Drucken (Standard: Aktiviert): Druckt den Rahmen mit aus.

* Textfluss: (Standard: Einstellung des tbergeordneten Objektes verwenden): Legt die
Schreibrichtung innerhalb des Rahmens fest. Bei Auswahl von Einstellung des tiberge-
ordneten Objektes verwenden wird die Standardschreibrichtung der Seite verwendet.

Bereich Inhaltsausrichtung:

* Vertikale Ausrichtung (Standard: Oben): Legt die vertikale Ausrichtung des Rahmenin-
halts fest. Diese Einstellung wirken sich neben dem Textinhalt auch auf andere Objekte
aus, die am Textbereich verankert sind (verankert “Als Zeichen®, “Am Zeichen“ oder “Am
Absatz"), wie z. B. Tabellen, Grafiken oder Zeichnungen.

Umlauf

Die Eigenschaften, die Sie auf der Seite Umlauf (Abbildung 31) festlegen kénnen, beeinflussen
mafgeblich das Aussehen (Layout) lhres Dokuments, besonders des Textes zum eingebetteten
Rahmen.
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Abbildung 31: Die Rahmenvorlage, Seite Umlauf.

Sie stellen hier den Abstand zwischen Rahmen und den Text innerhalb der Rahmenbegrenzung
ein sowie den Umlauf des Textes um den Rahmen.
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Im Bereich Einstellungen wird festgelegt, wie der Text um einen eingebetteten Rahmen lauft. Klei-
ne Icons zeigen Textverlauf und Rahmen an:

Kein: Platziert den Rahmen in einer eigenen Zeile im Dokument. Der Text im Dokument er-
scheint Uber und unter dem Rahmen, nicht jedoch zu seinen Seiten. Mit zunehmender
Rahmenho6he wird der Text weiter auseinander geschoben.

Vor: Ist zwischen dem linken Textrand und dem Rahmen gentigend Platz vorhanden, um-
lauft der Text den Rahmen auf der linken Seite.

Hinter: Ist zwischen dem rechten Textrand und dem Rahmen gentigend Platz vorhanden,
umléauft der Text den Rahmen auf der rechten Seite.

Parallel (Standard): Lasst den Text um den Rahmen herum laufen.

Durchlauf: Stellt den Rahmen vor den Text. Je nach Einstellungen des Hintergrundes (s.
Seite Hintergrund, S. 38), verdeckt der Rahmen den Text oder der Rahmen und dessen
Inhalt ist mehr oder weniger transparent und der Text scheint durch den Rahmen hindurch.

Optimal: Der Textumlauf erfolgt automatisch um den Rahmen. Betragt der Abstand zwi-
schen Rahmen und Seitenrand weniger als 2 cm betrégt, wird der Textumlauf unterbunden.

Um einen Text um eine Tabelle laufen zu lassen, setzen Sie die Tabelle in einen

Tipp Rahmen und lassen dann den Text um den Rahmen laufen.

Der Abstand zwischen der Rahmenbegrenzung und Objekten innerhalb des Rahmens (Text, Bilder,
Grafiken, Draw-Zeichnungen u. a.) wird im Bereich Abstand festgelegt:

Links (Standard: 0,20 cm): Abstand zwischen dem linken Rahmenrand und dem Text.
Rechts (Standard: 0,20 cm): Abstand zwischen dem rechten Rahmenrand und dem Text.
Oben (Standard: 0,20 cm): Abstand zwischen dem oberen Rahmenrand und dem Text.
Unten (Standard: 0,20 cm): Abstand zwischen dem unteren Rahmenrand und dem Text.

Zum Textumlauf kbénnen im Bereich Optionen zusatzliche Festlegungen getroffen werden:

Erster Absatz (Standard: Nicht aktiviert): Beim Verschieben des Rahmens aus dem Absatz
heraus, wird der Text des nachsten Absatzes nicht mehr umflossen. Der nachste Absatz
wird immer unter dem Rahmen begonnen.

Im Hintergrund (nur fur die Umlaufart Durchlauf verfigbar; Standard: Nicht aktiviert): Legt
den Rahmen in den Hintergrund (hinter den Text). Der Rahmen scheint durch den Text
durch. Das ist z. B. fur Grafiken innerhalb eines Rahmens eine Formatierungsmoglichkeit.

Kontur (nur fur die Umlaufarten Vor, Hinter, Parallel und Optimal verfigbar; Standard:
Nicht aktiviert): L&sst den Text um die Objektform laufen. Diese Option ist fur die Umlaufart
Durchlauf wie auch fiir Rahmen nicht verfligbar. Um die Kontur eines Objekts zu andern,
wahlen Sie das Objekt aus und wahlen dann Format - Umlauf - Kontur bearbeiten.

Nur auBBen (nur verfgbar, wenn die Option Kontur (fir die Umlaufarten Vor, Hinter, Paral-
lel und Optimal verfigbar) ausgewahlt wurde; Standard: Nicht aktiviert): Lasst den Text nur
um die Objektkonturen, nicht jedoch in offene Bereichen innerhalb der Objektform laufen.
Diese Option ist nicht fir Rahmen verfiigbar.

Hintergrund

Analog der Hintergrund in den Absatzvorlagen (S. 24) lasst sich fir Rahmenvorlagen eine Hinter-
grundfarbe oder eine Grafik wéhlen. Der einzige Unterschied ist, dass der Transparenzgrad einge-
stellt werden kann:

Transparenz (Standard: 0 %): Stellen Sie die Transparenz in % ein, um den Rahmeninhalt
fur Text durchsichtig zu machen.
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Umrandung

Auch hier wird auf die Ausfiihrungen zu den Absatzvorlagen, Umrandung (S. 25) verwiesen. Die
Option Mit dem nachsten Abschnitt verschmelzen ist jedoch nicht vorhanden.

Spalten

Die Seite Spalten (Abbildung 32) wird verwendet, um Text innerhalb eines Rahmens spaltenférmig
zu formatieren. Sie legen hier Spaltenanzahl und deren Breite fest. Die Seite ist in die drei Berei-
che Vorgaben, Breite und Abstand sowie Trennlinie unterteilt.

F '
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Abbildung 32: Die Rahmenvorlage, Seite Spalten.

Standardmaldig wird ein einspaltig Text vorgegeben. Erst mit der Erhéhung der Spaltenanzahl sind
weitere Feld fur eine Anderung verfiigbar. Sind die Vorgaben besonders hinsichtlich des Spalten-
abstandes nicht ausreichend, deaktivieren Sie das Kontrollkastchen “Automatische Breite* und
andern die Werte. Auch eine genaue Positionierung der Trennlinie zwischen zwei Spalten ist mog-
lich. Das Vorschaufeld rechts oben zeigt nur die Spalten, nicht die Seite an und gibt eine Voran-
sicht zu den gewéhlten oder geanderten Einstellungen.

Im Bereich Vorgaben wird die Spaltenanzahl festgelegt:

* Spalten (Standard: 1): Geben Sie die gewtiinschte Spaltenanzahl fir den Rahmen ein. Die
Spalten werden gleichmafig Uber die Rahmenbreite verteilt. Au3erdem kénnen Sie auch
rechts neben dem Eingabefeld fir die Spaltenzahl eines der vordefinieren Spaltenlayouts
auswahlen.

Die beiden anderen Bereiche dienen der Formatierung der Spalten. Der Bereich Breite und Ab-
stand erlaubt die Einstellung der Breite der Spalten und deren Abstande:

* Spalte: Zeigt die Spaltennummer an. Wenn im Feld Spalten mehr Spalten eingestellt sind,
als als im Dialogfenster darstellbar ist, werden ein linker und ein rechter Pfeil zuganglich,
die die Spaltenanzeige eine Spalte nach links oder rechts bewegen.
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¢ Breite: Wenn das Kontrollkastchen “Automatische Breite" nicht aktiviert ist, kdnnen Sie
die Breite der Spalte andern.

* Abstand: Geben Sie den gewunschten Abstand zwischen den Spalten ein.
Wenn das Kontrollkastchen “Automatische Breite” aktiviert ist, l&sst sich nur das linke
Feld andern: Der Abstand zwischen den Spalten wird einheitlich eingestellt.
Wenn das Kontrollkastchen “Automatische Breite" nicht aktiviert ist, l&sst sich der Ab-
stand zwischen allen eingestellten Spalten andern: Im linken Feld zwischen den Spalten 1
und 2 und im rechten Feld zwischen den Spalten 2 und 3.

* Automatische Breite (Standard: Aktiviert): Den Spalten werden die gleiche Breite zuge-
ordnet. Sollen die Spalten verschiedene Breiten haben, deaktivieren Sie dieses Kontroll-
kastchen.

Uber den Bereich Trennlinie , der nur verfligbar ist, wenn zwei oder mehr Spalten im Feld Spalten
ausgewahlt wurden, lasst sich das Layout der Spalten weiter verfeinern:

* Stil (Standard: kein): Legt die Linienart der Spaltentrennlinie fest. Erst wenn Sie eine ande-
re Linienart wahlen, sind die anderen Einstellméglichkeiten zuganglich.

* Hohe (Standard: 100 %): Lange der Trennlinie in Prozent der Spaltenhdhe.
* Farbe (Standard: Schwarz): Farbe der Spaltentrennlinie.

* Breite (Standard: 0,25 pt): Breite der Spaltentrennlinie in pt. Sie kdnnen die Breite auch in
einer anderen Maleinheit angeben.

* Position (Standard: Oben): Die vertikale Ausrichtung der Trennlinie. Das Feld ist nur ver-
flgbar, wenn das Feld Héhe kleiner als 100% ist.

Makro

Legt das Makro fest, dass beim Klicken auf einen Rahmen ausgefihrt werden soll. Makros sind fiir
Rahmen nur in Online- oder HTML-Dokumenten sinnvoll einsetzbar. Zur Makro-Programmierung
finden Sie weiter Anwendungsmaglichkeiten in folgenden LibreOffice Dokumentationen:

* Handbuch "Erster Schritte", Kapitel 13 — Einfiihrung in Makros.
* 'Kurzanleitungen "Makroprogrammierung".

Seitenvorlagen

LibreOffice verwendet Seitenvorlagen, um die Seitengrof3e, die Ausrichtung von Seiten, Rander,
Kopf- und Ful3zeilen und weitere Eigenschaften der Seite zu definiert. Im Gegensatz zu Absétzen
oder Zeichen, deren Eigenschaften auch direkt tber die Symbolleiste einstellbar sind, lassen sich
die Seiteneigenschaften nur Gber die Seitenvorlagen andern. Auch bei der Anpassung tber das
Meni Format > Seite wird die Seitenvorlage selbst geandert. In diesem Abschnitt wird beschrie-
ben, wie neue Seitenvorlagen erstellt werden und welche Auswirkungen die Einstellungen auf den
verschiedenen Seiten der Formatvorlage haben.

Eine neue Seitenvorlage erstellen

Um eine neue Seitenvorlage zu erstellen, 6ffnen Sie das Formatvorlagenfenster (liber die Funkti-
onstaste F11, das Menil Format > Formatvorlagen oder das Symbol || oder © in der Symbol-
leiste Format zu erreichen) und klicken auf das Symbol um die Seitenvorlagen anzuzeigen. Mit ei-
nem Rechtsklick auf eine vorhandene Seitenvorlage oder in den leeren Bereich des Fensters 6ff-
net sich ein Kontextment: Der Menipunkt Neu o6ffnet ein Dialogfenster zur Bearbeitung der Sei-
tenvorlage (Abbildung 33). Uber acht Seiten lassen sich die Eigenschaften fiir die Seitenvorlagen
einstellen.
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Verwalten

Diese Seite wurde bereits in “Die Seite Verwalten” auf Seite 6 beschrieben. Ein Beispiel soll das
Arbeiten mit Seitenvorlagen, insbesondere mit der Folgevorlage demonstrieren.

Sie mochten ein Dokument erstellen, das eine Titelseite hat, die sich von den eigentlichen Seiten
des Dokuments unterscheidet. Die nachfolgenden Seiten sollen wie bei einem Buch einen linke
und eine rechte Seite haben.

* Titelseite soll:
° keine Kopfzeile haben,
° keine Seitennummer haben,
° linke und rechte Rand sollen gleich sein.

¢ Dokumentenseite:
° linke und rechte Seiten sollen sich abwechseln,
° nach der Titelseite wird mit einer rechten Seite angefangen.

Sie konnen die in LibreOffice Writer vordefinierte Seitenvorlage Erste Seite fur die Titelseite und
Linke Seite und Rechte Seite fiir die Dokumentenseiten verwenden.

Wabhlen Sie in der Seitenvorlage Ersten Seite im Feld Folgevorlage den Eintrag Rechte Seite.
Wabhlen Sie in der Seitenvorlage Rechte Seite im Feld Folgevorlage den Eintrag Linke Seite.
Wabhlen Sie in der Seitenvorlage Linke Seite im Feld Folgevorlage den Eintrag Rechte Seite.

Falls gewlnscht sind in den Seitenvorlagen Linke Seite und Rechte Seite noch die Kopf- bzw.
Ful3zeilen zu aktivieren und die Seitenzahlen einzusetzen. Weitere Erlauterungen werden in den
weiteren Abschnitten gegeben.

Seitenformat und Rander

Im Reiter Seite werden Angaben zum Seitenformat, zu den Seitenrandern (typografisch: Stege)
und weiteren Layouteinstellungen gemacht. Neben den Bereichen ist rechts oben eine Vorschau
zu den Anderungen an der Seite zu sehen (Abbildung 33).

Angaben zum Seitenformat sind im Bereich Papierformat vorzunehmen:

* Format (Standard: A4): Aus einer Auswabhlliste Iasst sich eine Papiergrof3e auswahlen. Ein
benutzerdefiniertes Papierformat erstellen Sie, indem Sie die Seitenabmessungen in die
unterhalb liegenden Felder H6he und Breite eingeben.

* Breite (Standard: aus der Auswahl im Feld Format abgeleitet): Breite des ausgewahlten
Papierformats. Fur ein benutzerdefiniertes Format geben Sie hier die Breite ein.

* Hoéhe (Standard: aus der Auswahl im Feld Format abgeleitet): Hohe des ausgewahlten Pa-
pierformats. Fir ein benutzerdefiniertes Format geben Sie hier die Héhe ein.

* Ausrichtung (Standard: Hochformat): Wéhlen Sie zwischen Hochformat und Querformat.
Die Anderung der Ausrichtung wirkt sich auf alle Seiten, die mit der Formatvorlage erstellt
wurden aus. Um in einem Dokument zwischen Hoch- und Querformat zu wechseln, ver-
wenden Sie den Menupfad Einfliigen > Manueller Umbruch ..., Option Seitenumbruch
und die Vorlage Querformat bzw. Standard, um zum Hochformat zuriickzukehren.

* Papierschacht: Papierzufuhr flr Drucker mit mehreren Papierschéachten. Es besteht auch
die Moglichkeit, jeder Seitenvorlage eine andere Papierzufuhr zuzuweisen. Beispielsweise
konnen Sie der ersten Seitenvorlage eines Schreibens einen anderen Papierschacht zu-
weisen und das Papier mit dem Briefkopf Ihrer Firma in diesen Schacht laden.

Der Abstand zwischen dem Papierrand und dem Dokumententext (einschliel3lich Kopf- und Ful3-
zeile) wird im Bereich Seitenrénder festgelegt:
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* Links / Innen (Standard: 2 cm): Abstand zwischen dem linken Seitenrand und dem Doku-
menttext. Beim Seitenlayout Gespiegelt ist das der Abstand zwischen innerem Text- und
innerem Seitenrand.

* Rechts | AuBen (Standard: 2 cm): Abstand zwischen dem rechten Seitenrand und dem
Dokumenttext. Beim Seitenlayout Gespiegelt ist das der Abstand zwischen &ulReren Text-
und aulRerem Seitenrand.

* Oben (Standard: 2 cm): Abstand zwischen dem oberen Seitenrand und dem Dokument-

text.
* Unten (Standard: 2 cm): Abstand zwischen dem unteren Seitenrand und dem Dokument-
text.
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Abbildung 33: Die Seitenvorlage, Allgemeine Formateinstellungen fiir die Seite.

Allgemein werden fur das Seitenlayout asymmetrische Seitenrdnder verwendet, sowohl fur die lin-
ken und rechten als auch fir die oberen und unteren Begrenzungen. Dadurch hat der Leser mehr
Platz, um das Buch oder das Dokument zu halten.

Es gibt zwei Grundregeln fur das Layout gedruckter Seiten:

a) Der auRere Rand (rechter Rand einer rechten Seite) ist groRRer als der innere Rand (linker
Rand einer rechten Seite).

b) Der untere Rand ist gré3er als der obere Rand.
Auf ihrer Webseite zum Desktop Publishing von About.com werden dazu weitere Hinweise zum
Seitenlayout gegeben.
Auch in Writer lassen sich im Bereich Layouteinstellungen Einstellungen zum Seitenlayout vorneh-
men:
* Seitenlayout (Standard: Rechts und Links): Aus einer Auswabhlliste bestimmen Sie das
Seitenlayout fur das aktuelle Dokument:

° Rechts und Links (Standard): Die Seitenvorlage zeigt gerade und ungerade Seiten
mit linken und rechten Seitenréandern an, wie im Bereich Seitenrédnder angegeben.

° Gespiegelt: Die Seitenvorlage zeigt gerade und ungerade Seiten mit inneren und &u-
Beren Seitenrdndern an, wie im Bereich Seitenrdnder angegeben . Verwenden Sie
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dieses Layout, wenn Sie die gedruckten Seiten wie ein Buch binden mdchten. Geben
Sie den Bundsteg als inneren Seitenrand ein.

° Nur Rechts: Die Seitenvorlage zeigt nur ungerade (rechte) Seiten an. Gerade Seiten
werden als leere Seiten angezeigt.
Wenn die erste Seite eines neuen Kapitels auf der rechten Seite beginnen soll, setzen
Sie das Seitenlayout auf Nur Rechts. Fir die folgenden Seiten wahlen Sie den Ein-
trag Gespiegelt. Die Kopf- und Ful3zeilen dieser gespiegelten Seiten miissen nicht
gleich sein.

° Nur Links: Die aktuelle Seitenvorlage zeigt nur gerade (linke) Seiten an. Ungerade
Seiten werden als leere Seiten angezeigt.

* Format: Das Nummerierungsformat fur die Seitenvorlage, z. B. fur die Seitennummern.

* Registerhaltigkeit: Richtet den Text mit der ausgewahlten Seitenvorlage an einem vertika-
len Seitenraster aus. Der Abstand des Rasters wird durch die Referenzabsatzvorlage be-
stimmt. Beachten Sie dazu auch die Ausfihrungen zur Registerhaltigkeit auf S. 11.

* Referenzabsatzvorlage: Absatzvorlage, die als Referenz fur die Textanordnung in der aus-
gewahlten Seitenvorlage dienen soll. Die H6he der in der Referenz-Formatvorlage angege-
bene Schrift bestimmt den Abstand des vertikalen Seitenrasters.

Far linke und rechte Seiten lassen sich jeweils eigene Seitenvorlagen definieren. Damit lassen sich
die Seiten sehr verschieden gestalten, wie z. B. durch:

* unterschiedliche Seitenrander,
* Kopf- und Ful3zeilen, wahlweise nur auf einer Seite,
» Darstellung von Grafiken oder Fotos nur auf einer Seite und Texte auf der anderen Seite.

In diesem Fall setzen Sie fur die zuerst verwendete Seitenvorlage auf der Seite Verwalten das
Feld Folgevorlage auf Linke Seite und das Seitenlayout auf Nur Links. Die ndchste Seite ist
dann die Seitenvorlage Linke Seite, in deren Feld Folgevorlage (auf der Seite Verwalten) Rech-
te Seite auszuwahlen ist. Das zugeordnete Seitenlayout wird auf Nur Rechts gesetzt.

In diesem Fall ordnen Sie der ersten Seite die vordefinierte Seitenvorlage Erste Seite zu. In dieser
Seitenvorlage setzen Sie auf der Seite Verwalten das Feld Folgevorlage auf Linke Seite. In die-
ser Seitenvorlage steht bereits die Folgevorlage auf Rechte Seite und das Seitenlayout auf Nur
Links. Die nachste Seite ist dann die Seitenvorlage Rechte Seite, in deren Feld Folgevorlage
(auf der Seite Verwalten) Linke Seite steht und das zugeordnete Seitenlayout auf Nur Rechts ge-
setzt ist.

Am Beginn eines Kapitels steht demnach zuerst eine Erste Seite, dann eine Linke Seite, eine
Rechte Seite, eine Linke Seite, eine Rechte Seite usw.

Hintergrund

Analog der Hintergrund in den Absatzvorlagen (S. 24) lasst sich fur die Seitenvorlage eine Hinter-
grundfarbe oder eine Grafik wahlen. Beachten Sie, dass Hintergrund und Grafik nur den Bereich
innerhalb der Rénder ausfillen. Soll auch der Bereich au3erhalb der Rander mit einer Hintergrund-
farbe belegt werden, so wird das tUber das Menl Extras > Tools > LibreOffice > Darstellung
durch Anderung des Dokumenthintergrundes realisiert.

Kopfzeile und Ful3zeile

Diese Seite legen die Eigenschaften fur die Kopfzeile bzw. Ful3zeile fest. Da Kopf- und Fuf3zeilen
die gleichen Einstellméglichkeiten bieten, werden sie in einem Abschnitt behandelt.

Fur jede Seitenvorlage lassen sich unterschiedliche Kopf- und Fuf3zeilen vorgeben, so dass das
Aussehen von linken und rechten Seiten anders gestaltet werden kann. Die erste Seite eines Kapi-
tels enthalt dann beispielsweise keine Kopfzeile. Das kdnnen Sie erreichen, indem Sie fir die er-
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stellte Seitenvorlage festlegen, ob die erste Seite auch, wie die Folgeseiten, eine Kopf-/Ful3zeile
haben soll.

Das Einrichten einer Kopf- oder Ful3zeile ist relativ einfach (Abbildung 34).
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Abbildung 34: Die Seitenvorlage, Seite Kopfzeile.

Zuerst aktivieren Sie das standardmaf3ig ausgeschaltete Kontrollkdstchen Kopfzeile einschalten.
Dadurch wird eine Kopfzeile in die aktuelle Seitenvorlage eingefugt. Kopfzeilen sind Bereiche in-
nerhalb des oberen Seitenrands, in die sich Text oder Grafiken einfligen lassen, die auch mit Um-
randungen oder Hintergrundfiullungen versehen werden kénnen. Die Breite der Kopf-/Ful3zeilen
entspricht der Breite des Dokumententextes. Soll die Breite grof3er sein, also in den Seitenrand
hineinragen, mussen Sie einen Rahmen mit der entsprechenden Breite in die Kopfzeile einfligen.

Mit eingefligter Kopfzeile werden weitere Optionen zuganglich:

L]

Inhalt links/rechts gleich (Standard: Aktiviert): Auf geraden und ungeraden Seiten wird
die gleiche Kopfzeile eingefligt. Bei nicht aktivierter Option, kdnnen fir linke und rechte
Seiten jeweils eigene Kopfzeile definiert werden (Abbildung 35).

Linke Kopfzeile Seite 2 Seite 3 Rechte Kopfzeile

Abbildung 35: Verschiedene Kopfzeilen fiir linke und rechte Seiten.

Gleicher Inhalt auf der ersten Seite (Standard: Aktiviert): Alle geraden und ungeraden
Seiten sowie auch die erste Seite erhalten die gleiche Kopfzeile. Bei nicht aktivierter Opti-
on, kann fur die erste Seite keine oder eine eigene Kopfzeile erstellt werden. Diese Option
ist nicht fur die Seitenvorlagen Linke Seite und Rechte Seite sowie fir Seitenvorlagen ver-
fugbar, die nur eine Seite definieren.

Linker Rand (Standard: 0): Der Abstand zwischen dem linken Seitenrand und dem linken
Rand der Kopfzeile.

Rechter Rand (Standard: 0): Der Abstand zwischen dem rechten Seitenrand und dem
rechten Rand der Kopfzeile.
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Abstand (Standard: 0,50 cm): Abstand zwischen dem unteren Rand der Kopfzeile und
dem oberen Rand des Textes.

Fir FulRzeilen: Abstand zwischen dem oberen Rand der FulRzeile und dem unteren Rand
des Textes.

Dynamischen Abstand verwenden (Standard: Nicht aktiviert): Bei einzeiliger Kopfzeile
wird der im Feld Abstand angegebene Wert eingehalten. Ist die Kopfzeile mehrzeilig, wird
der Abstand zum Text mit jeder Zeile verkirzt. Bei dem eingestellten Standardabstand von
0,5 cm ist bereits die 2. Zeile bis an den Dokumententext herangeruckt.

Hohe (Standard: 0,50 cm): H6he der Kopfzeile.
Fir FulRzeilen: Hohe der Ful3zeile.

Hoéhe dynamische anpassen (Standard: Aktiviert): Die Hohe der Kopfzeile wird automa-
tisch an den Inhalt der Kopfzeile angepasst. Bei nicht aktivierter Option wird der Kopfzei-
lentext nur fir eine Zeile angezeigt, sofern die Standardeinstellungen aktiviert sind. Weitere
Zeilen sind nicht mehr sichtbar.

Mehr: Uber die Schaltflache Mehr kénnen Sie eine Umrandung oder einen anderen Hinter-
grund fir die Kopfzeile festlegen. Da die Einstellméglichkeiten zu Umrandungen und Hin-
tergriinden denen der Absatzvorlage entsprechen, wird an dieser Stelle auf die Abschnitte
der Absatzvorlage Hintergrund, S. 24 und Umrandung, S. 25 verwiesen.

Um den Cursor schnell vom Dokumenttext in die Kopf- oder FuRzeile zu setzen,

Tipp driicken Sie Strg+BildAuf bzw. Strg+BildAb. Mit der gleichen Tastenkombination

positionieren Sie den Cursor wieder in den Dokumenttext.

Spalten

Die Seite Spalten entspricht der gleichnamigen Seite in den Rahmenvorlagen. Deshalb wird zur
Erklarung zu den Einstellméglichkeiten auf den Abschnitt Spalten auf Seite 39 verwiesen.

FuRnote

Eine Ful3note ist eine Anmerkung, Legende, Bemerkung, Quellenangabe oder weiterfihrende Er-
klarung zu einem Text, die im Druck-Layout aus dem Flie3text ausgelagert wird, um den Text flis-
sig lesbar zu gestalten. Auf dieser Seite legen Sie den Ful3notenbereich einschlief3lich der Trennli-
nie zwischen der FuZnote und dem Dokumententext fest (Abbildung 36).

Im FulBnotenbereich legen Sie die Hohe und Breite der Ful3note fest:

Hohe maximal wie Seite:(Standard: Aktiviert): Die Hohe des Fulinotenbereichs wird auto-
matisch an die Anzahl der Ful3noten angepasst.

Maximale Héhe der FuBnote: (Standard: Deaktiviert, wenn aktiviert 2,00 cm): Maximalho-
he des Ful3notenbereichs. Aktivieren Sie dieses Feld, wenn Sie die Ful3notenhdhe selbst
kontrollieren wollen und geben Sie die Hohe des Ful3notenbereichs ein.

Abstand zum Text: (Standard: 0,10 cm): Abstand zwischen dem unteren Seitenrand und
der ersten Zeile des Ful3notenbereichs.

Achtung Der FulR3notenbereich wird automatisch an Hand der Anzahl der eingefugten Ful3-

ﬁ noten berechnet. Wenn Sie den Ful3notenbereich selbst kontrollieren wollen, wah-

len Sie den FulRnotenbereich nicht gré3er als den Seitenhdhe.

Der Bereich Trennlinie formatiert die Art, Position, Ldnge und Farbe der Trennlinie:

L]

Position (Standard: Links): Horizontale Ausrichtung der Trennlinie zwischen Textkorper
und Ful3notenbereich.
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» Stil (Standard: Durchgehend): Auswahl der Linienart aus der Auswahlliste. Wenn keine
Trennlinie angezeigt werden soll, wahlen Sie Keine ein.

* Dicke (Standard: 0,50 pt): Starke der Trennlinie.
* Farbe (Standard: Schwarz): Farbe der Trennlinie.
* Léange (Standard: 25 %): Lange der Trennlinie in Prozent zur Seitenbreite.

* Abstand zum FuBnoteninhalt (Standard: 0,10 cm): Abstand der Trennlinie zur ersten Zei-
le des FulRnotenbereichs.

Seitenvorlage: Standard l&]
!‘u‘erwalteniSeiteiHintergrund IKopfzeile|FuEzei|e!Umrandung|SpalteniFUBﬂDtE |

FuBnotenbereich
@ Hohe maximal wie Seitei
) Maximale Héhe der FuBinote 2,00 cm
Abstand zum Text 0,10 cm =

Trennlinie
Poczition |Lir|k5 El
stil —
Dicke 0,50 pt =
Farbe |- Schwarz El
Linge 25% =
Abstand zum FuBnoteninhalt 0,10 cm =

0]4 ] l Zuweisen ] l Abbrechen I l Hilfe l l Zurick
Abbildung 36: Die Seitenformatvorlage, Seite Ful3note.

Beispiel: Ein Buch - Die ersten Seiten eines Kapitels

In nachfolgendem Beispiel sollen die Seitenvorlagen fir ein Buch erstellt werden. Tabelle 2 zeigt
die gewlinschten Layouteigenschaften fur die zu verwendenden Seiten, wie sie flr ein typisches
Buch verwendet werden.

Tabelle 2: Eigenschaften der Seitenvorlagen fiir die Kapitel eines Buches

Seite

Formatierung/Eigenschaften

Einstellungen der Seitenvorlage

Rechte Seite
(Erste Seite)

Die erste Seite ist eine Rechte Seite Seite: Seite > Seitenlayout: Nur

mit ungerader Nummerierung

Keine Kopf oder Ful3zeile

Rechts

Seite: Kopfzeile > Kopfzeile ein-
schalten: Nicht aktiviert

Der obere Rand dieser Seite soll gro- Seite: Seite > Seitenrander > Oben:
Rer sein als der der anderen Seiten. 6.00cm
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Seite

Formatierung/Eigenschaften

Einstellungen der Seitenvorlage

Standard Die Standardseite soll eine gespiegelte

Seite sein (abwechselnd Linke Seite —
Rechte Seite).

Eine Seite mit Kopfzeile: Seiten-Nr. au-
Ren, Kapiteltberschrift mittig.

Seite: Seite > Seitenlayout: Gespie-
gelt

Seite: Kopfzeile > Kopfzeile ein-
schalten: Aktiviert

Seite: Kopfzeile > Kopfzeile > Inhalt
links/rechts gleich: Nicht aktiviert

Ein Buchkapitel beginnt normalerweise mit einer rechten Seite. Die erste Seite ist dabei anders ge-
staltet als die Folgeseiten. Bei doppelseitigem Druck sind die Innen- und AuRenrander (typo-
grafisch: Bund- und AuRenstege) verschieden fiir die linken und rechten Seiten. Seitenzahlen in
Kopf- oder Ful3zeilen befinden sich an den jeweiligen AuRenrandern der Seiten und der innere

Rand ist groRRer, da hier das Buch gebunden werden soll.

Abbildung 37 zeigt die Abfolge der Seiten von der ersten Seite (eine Rechte Seite) zu den gespie-
gelten Standardseiten mit abwechselnden linken und rechten Kopfzeilen, wobei die Seitenzahl mit
dem Symbol # gekennzeichnet ist.

Die Erstellung der Seitenvorlagen erfolgt in finf Schritten:
Schritt 1: Die Seitenvorlage Rechte Seite (Erste Seite):

v

#

Rechte
Seite Seite

~__p» Standard p- Standard

#

Seite

Abbildung 37: Seitenvorlage fir ein Buch mit Titelseite und ver-
schiedenen Kopfzeilen flir die Standardseiten.

1) Im gedffneten Formatvorlagenfenster (Giber die Funktionstaste F11, das Menu Format >
Formatvorlagen oder das Symbol (5] oder © in der Symbolleiste Format zu erreichen)
wahlen Sie das Symbol fir die Seitenvorlagen aus. Es wird die Liste der vorhandenen Sei-

2)

tenvorlagen angezeigt.

Ein Rechtsklick auf die Seitenvorlage Rechte Seite 6ffnet ein Kontextmeni aus dem der

Eintrag Andern auszuwéhlen ist.

3) Auf der Seite Verwalten andern Sie das Feld Folgevorlage auf Standard (Abbildung 38).
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4)

5)
6)

Seitenvorlage: Rechte Seite @

Verwalten |Seite|Hintergrund|Kopfzei|e!FuEzeiIe|Umrandung|Spalten|FuBnote|

Formatvorlage

MName Rechte Seite

Folgevorlage

Endnc-te

Verknipfen mit Exste Seite

Bereich FuBinote
N HTML
Enthilt Linke Seite
Querformat

297 cm + Von ob

Arabisch, Hoch, RSl

Standard

Abbildung 38: Die Seitenvorlage, Seite Verwalten: Andern der Folgevorlage.

Auf der Seite Seite wird ein groRerer linker Rand (3,0 cm) als Binderand und ein grél3erer
oberer Rand (6,0 cm) eingestellt, um die KapitelUberschrift etwas tiefer zu setzen. Die wei-
teren Rander: Rechter Rand: 2,0 cm; unterer Rand: 2,5 cm.

Die Kopf- und FuRRzeilen dirfen auf den gleichnamigen Seiten nicht eingeschaltet sein.
Mit OK speichern Sie die Eintragungen fir diese Seitenvorlage.

Schritt 2: Einstellungen der Seitenvorlage Standard:

1)
2)
3)
2)

5)

Nach Rechtsklick auf die Seitenvorlage Standard und Auswahl von Andern aus dem Kon-
textmenu kénnen Sie die Einstellungen der Seitenvorlage bearbeiten.

Auf der Seite Verwalten prifen Sie, ob im Feld Folgevorlage die Seitenvorlage Standard
eingetragen ist.

Auf der Seite Seite ist unter Seitenlayout Gespiegelt aus der Liste zu wahlen (Die Feldna-
me Links und Rechts im Bereich Seitenrédnder wechseln dann auf Innen und AuBBen).

Auf der Seite Kopfzeile: Aktivieren Sie das Kontrollkastchen Kopfzeile einschalten und
deaktivieren Sie das Kontrollk&stchen Inhalt links/rechts gleich (Abbildung 39).

Mit OK speichern Sie die Eintragungen.

Seitenvorlage: Rechte Seite ﬁ

|Verwalten|Seite|Hintergrund Kopfzeile |FuBzeiIe|Umrar|dung|Spalten|FuBnote|

Kopfzeile
[¥] Kopfzeile ginschalten
[C4nhalt links/rechts gleich
[¥] Gleicher Inhalt auf der ersten Seite

Abbildung 39: Die Seitenvorlage, Seite Kopfzeile: Einstellungen fir verschiede-
ne Kopfzeilen.

Schritt 3: Einstellungen fiir die Absatzvorlage Uberschrift 1 auf der ersten Seite (Seitenvor-
lage: Rechte Seite):

1)

2)

3)

Aus den Absatzvorlagen wéahlen Sie die Vorlage Uberschrift 1 und gehen mit Rechtsklick
Andern in den Editiermodus.

Auf der Seite Textfluss sind im Bereich Umbriiche die Kontrollkastchen Einfligen und mit
Seitenvorlage zu aktivieren und im Feld Typ Seite und darunter Rechte Seite auszuwéah-
len (Abbildung 40).

Mit OK speichern Sie die Einstellungen.
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Umbriiche

[¥] Einfagen Typ n Position  [Vior :l

[] it Seitenvorlage i'teg Seitennummer |0 =

-

Abbildung 40: Die Absatzvorlage Uberschrift 1, Seite Textfluss.

Schritt 4: Beginn eines neuen Kapitels:

Der erste Absatz, das ist die Kapiteltiberschrift, wird mit der Absatzvorlage Uberschrift 1 forma-
tiert.

StandardmaRig ist die Absatzvorlage Uberschrift 1 mit der ersten Gliederungs-
Notiz ebene verbunden. Die Zuordnung der Absatzvorlage zu den Gliederungsebenen
erfolgt Gber das Menii Extras > Kapitelnummerierung.

Schritt 5: Einstellungen der Kopfzeile:

1) Beim Schreiben des Textes gelangen Sie nach einem Seitenumbruch auf der ersten Seite
auf eine linke Seite. Mit einem Klick auf die Kopfzeile gelangen Sie in den Bearbeitungsmo-
dus fiir die Kopfzeile (oder durch die Tastenkombination Strg+Bild auf). Die Anderungen
werden auf allen Linken Seiten sichtbar sein. Positionieren Sie den Cursor links und fligen
Uber das Meni Einfiigen > Feldbefehl > Seitennummer eine Seitennummer ein.

2) Mit der Tab-Taste setzen Sie den Cursor in die Mitte der Kopfzeile und 6ffnen tber die Tas-
tenkombination Strg+F2 oder Giber das Ment Einfugen > Feldbefehle > Andere ... das
Dialogfenster Felder (Abbildung 41).

Auf der Seite Dokument wahlen Sie im Bereich Typ den Eintrag Kapitel und im Bereich
Format den Eintrag Kapitelname. Der Wert im Feld Ebene sollte auf 1 stehen.

rFeh:Ier ﬁﬁ

Dokument iQuer\.rerweise Funktionen Dokumentinfo!‘u’ariablenIDatenbank|

Typ Auswihlen Format

Absender Kapitelname

Benutzer Kapitelnurnmer

Dateiname Kapitelnurmmer chne Trennze
Daturn Kapitelnurmmer und Marme

Dokumentvorlage

Seite
Statistik
Uhrzeit

Ebene

Einfiigen H Schliefen H Hilfe

Abbildung 41: Das Dialogfenster Felder, Seite Dokument.

3) Mit Einfiigen iibernehmen Sie den Kapitelnamen aus der Uberschrift in die Kopfzeile.

4) Auf einer Rechten Seite editieren Sie die Kopfzeile (Klick in die Kopfzeile) und betatigen
Sie die Tab-Taste, so dass der Cursor in der Mitte der Kopfzeile steht.

5) Fugen Sie einen Querverweis auf die Kapitelberschrift ein (Dialogfenster Felder, Seite
Querverweise, Typ: Uberschriften, Auswahl: Die entsprechende Uberschrift, Referenz: Re-
ferenztext; s. Abbildung 42).
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T (s

Dokument| Querverweise iFunk‘tionen |Dokumentinfo|‘ufariablen IDatenbank|

Typ Auswahl
Referenz setzen Kapitel 1. Jager des verlorenen Schatzes

Referenz einfligen

Mummerierte Absatze
Lesezeichen

Referenz einfiigen

Kapitel

Referenztext
Oberhalb/Unterhalb

Wie Seitenverlage
Mummer

Mummer (kein Kontext)
Murmnmer (voller Kontext)

Mame |Kapitel 1. Jager des verlorenen Schatzes

Wert

Einfigen H Schliefen ][ Hilfe

(8 4

Abbildung 42: Das Dialogfenster Felder, Seite Querverweise: Einfli-
gen der Kapitelliberschrift in die Kopfzeile.

6) Betatigen Sie noch einmal der Tab-Taste, so dass der Cursor nach rechts in der Kopfzeile
springt. Geben Sie die Seitennummer ein (Einfligen > Feldbefehl > Seitennummer).

Achtung Wenn Sie die Tabulatorpositionen andern mochten, dann andern Sie diese Uber
die Absatzvorlage Uberschriften. Andern Sie auf keinen Fall manuell die Positi-
on und die Art der Tabulatoren.

Listenvorlagen

Listenvorlagen werden auch nummerierte Vorlagen genannt. Es lassen sich eine Vielzahl von Lis-
ten definieren: Von einfachen Aufzéahlungslisten bis zu verschachtelte Listen mit mehreren Ebenen
(Multi-Level Listen). Fur die Listenelemente werden der Einzug, die Ausrichtung und die Art der
Nummerierung oder der Aufzéhlung festgelegt. Listenvorlagen werden in Absatzvorlagen integriert,
so dass die nicht von der Listenvorlage definierte Formatierung von der Absatzvorlage Gbernom-
men wird. Verwenden Sie eine Listenvorlage separat, so wird die bis dahin geltende Absatzvorlage
zu Grunde gelegt.

Der Vorteil der Verwendung von Listenvorlage ist, wie bei allen anderen Vorlagen auch, die Ein-
heitlichkeit und Konsistenz des Dokuments hinsichtlich der Formatierung sowie die schnellen An-
derungsmadglichkeiten Gber das gesamte Dokument hinweg.

Obwohl sich einfache Listen durch die Verwendung der in der Symbolleiste Aufzdhlung und Num-
merierung befindlichen Symbole Nummerierung ein/aus und Aufzahlungszeichen ein/aus er-
stellen lassen, ist das Ergebnis oftmals nicht so wie erwartet. Das gilt insbesondere, wenn komple-
xe Listen mit mehreren Ebenen oder verschiedene Formatierungen in einer Liste gefordert oder
gewiinscht sind. Hinzu kommt, dass eine nachtragliche Anderung der Formatierung der manuell
erstellten Listen sehr aufwandig und zeitraubend ist und fur jede einzelne Liste separat durchge-
fuhrt werden muss.
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In LibreOffice werden die Begriffe 'Nummerierte Liste' und 'Listenvorlage' oftmals
etwas inkonsistent verwendet, aber sie stellen dasselbe dar. So werden z. B. im

Notiz Formatvorlagenfenster (Sondertaste F11) in der Quickinfo zum Symbol Listenvor-
lagen 'Listenvorlagen' angezeigt. An anderer Stelle in der Hilfe diese aber als
‘Nummerierungsvorlagen' bezeichnet.

Verschachtelte Listen

Eine verschachtelte Liste ist eine nummerierte oder mit Aufzahlungszeichen versehene Liste, de-
ren Elemente ebenfalls Listen enthalten, die wiederum mit Nummern oder Aufzahlungszeichen ver-
sehen sein kdnnen. Statt einer rein durchnummerierten Liste mit den Eintragen 1, 2, 3 .. werden
haufig unterhalb dieser Eintrdge eingebettete und eingezogene Listen mit Nummerierungen wie a,
b, c.. oder i, ii, iii .. 0. &. verwendet. Mit Hilfe der Listenvorlagen lassen sich alle moglichen Kombi-
nationen von Nummerierungen erstellen. Verschachtelte Listen kénnen sogar Nummerierungs-
und Aufzahlungszeichen mischen.

Es gibt prinzipiell keinen Unterschied zwischen der Erstellung einer Listenvorlage fir einfache und
verschachtelte Listen; letztere erfordern ein wenig mehr Arbeit. In Kapitel 3 "Arbeiten mit Text" wird
ein Beispiel einer verschachtelten Liste gezeigt. In jenem Beispiel wurde die Liste aus einer vorde-
finierten Gliederungsvorlage erstellt, wahrend in diesem Abschnitt ein allgemeinerer Ansatz zum
Tragen kommt, der weitergehenden Anforderungen besser entspricht.

Neue Listenvorlagen erstellen

Das Dialogfenster fur die Listenvorlagen besteht aus sieben Eigenschaftsseiten. Die Seite Verwal-
ten wurde bereits im gleichnamigen Abschnitt auf S. 6 beschrieben.

Aufzédhlungszeichen

Die Seite Aufzdhlungszeichen enthéalt acht vordefinierte, formatierte Listen (Abbildung 43). Um
eine dieser Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren Um-
randung hervorgehoben wird. Ein Quickinfo weist auf die Aufzahlungszeichen vor den Listenele-
menten hin. Diese Aufzahlungszeichen sind Zeichen aus einem Zeichensatz.

Nummerierungsart: Nummerierung 1 &J
‘u_rerwa Iten' Aufzihlungszeichen %[qummé-r};run gsar‘.c";’(j-l-i.ea :Erungmgé-i Id ;i-;-‘;-s-i-t"i.on ElC];:rtmr'uan
| Auswahl
. 8 L] ]
- L] * N
Kleine ausgefillte kreisfarmige Aufzdhlungszeichen
. ] $ )

Abbildung 43: Das Dialogfenster Listenvorlage, Seite Aufzdhlungszeichen.

Nummerierungsart

Die Seite Nummerierungsart enthalt acht vordefinierte, formatierte Listen (Abbildung 44). Um
eine dieser Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren Um-
randung hervorgehoben wird. Ein Quickinfo weist auf die Nummerierungszeichen vor den Listen-
elementen hin. Die Nummerierungszeichen sind Ziffern.
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Nurnmerierungsart: Nummerierung 1

Auswahl

|1u'erwa|ter1 IAuszthungszeichenlNUmmEriErUﬂgsar‘E |G|iederung |Bi|d iPosition |Optionen |

1) 1
2) Z
3) 3

(1)
(2)
(3)

1.

|GmBe romische Zahlen L. I I
111,

Abbildung 44: Das Dialogfenster Listenvorlage, Seite Nummerierungsatrt.

Gliederung

Die Seite Gliederung enthélt acht vordefinierte, formatierte Listen (Abbildung 45). Um eine dieser
Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren Umrandung
hervorgehoben wird. Ein Quickinfo weist auf die Gliederungszeichen vor den Listenelementen hin.
Diese Gliederungszeichen kénnen Zeichen aus einem Zeichensatz, aber auch Bilder oder Grafiken
sein, die auf der Seite Optionen (s. S. 56) angepasst werden kénnen.

=

MNummerierungsart: Mummerierung 1

eS|

|‘u‘erwalter1 |Aufzéih|ungszeichen INummerierungﬂ Gliederung |Bi|d |Pos-itior1 iOptionen |

Auswahl
1 & i 1
3 a) (@) 1.
! [ ki |
Mumerisch, nurnerisch, kleine Buchstaben, kleiner ausgefilliter kreisférmiger Gliederungspunkti
L I L A I 1
[ L] [ 1

Abbildung 45: Das Dialogfenster Listenvorlage, Seite Gliederung.

Bild

Die Seite Bild enthalt acht vordefinierte, formatierte Listen (Abbildung 46).

=

Mummerierungsart: Mummerierung 1

|‘u‘erwalter1 |Aufzéih|ungszeichen INummerierungsart|G|iederung|Ei|d |Pos-itior1 iOptionen |

Auswahl

-

A 4
-

CA\ProgiLibreOffice\programi.\sharehgalleny\bullets\bluarrow.gif

™

>

m

Abbildung 46: Das Dialogfenster Listenvorlage, Seite Bild.
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Um eine dieser Vorlagen zu nutzen, klicken Sie auf das Vorschaubild, das dann mit einer breiteren
Umrandung hervorgehoben wird. Ein Quickinfo weist auf die Grafik vor den Listenelementen hin.
Die Aufzahlungszeichen sind Bilder oder Grafiken, die auf der Seite Optionen (s. S. 56) auch an-
gepasst werden kénnen.

Position

Die Seite Position erlaubt die genaue Einstellung der Absténde, Einztige und Ausrichtung sowohl
fur die Symbole als auch fur den Text der Listenelemente (Abbildung 47). Zusammen mit der Seite
Optionen konnen Sie die Listenvorlage genau nach Ihren Vorstellungen erstellen.

MNummerierungsart: Mummerierung 1 @
i‘u‘erwalten EAuszthungszeichen NummerierungsartEGIiederung Bild | Position iOptinnen|
Ebene Position und Abstand
Mummerierung wird gefolgt ven Tabulator :l
2
3 bei 0,50 cm =
4
g Ausrichtung der Nummerierung Links :I
; Ausgerichtet bei 0,00 cm %
? Einzug bei 0,50 em =
10 =inzug ;s 3
1-10
a)
l Standard |
[ 0K ] l Zuweisen ‘ ‘ Abbrechen J I Hilfe ‘ | Zuriick J

[

Abbildung 47: Das Dialogfenster Listenvorlage, Seite Position.

Die Seite istin mer_]rere Bereiche unterteilt. Im mittleren unteren Bereich befindet sich ein Vor-
schaufenster, das Anderungen an den Einstellungen sichtbar macht.

Der Bereich Ebene zeigt alle zehn Ebenen an, die einzeln bearbeitet werden kénnen. Der letzte
Eintrag 1 — 10 erlaubt die gleichzeitige Einstellung aller Ebenen. Wahlen Sie zuerst die zu bearbei-
tenden Ebenen aus.

Im Allgemeinen ist es glnstiger, die Einstellungen nicht in der im Bereich Position und Abstand
dargestellten Reihenfolge vorzunehmen, sondern in der nachfolgend beschriebenen Abfolge:

*  Nummerierung wird gefolgt von (Standard: Tabulator): Abstandselement, das der Num-
merierung folgt und den Abstand zwischen dem Nummerierungs-/Aufzahlungszeichen und
dem Listentext herstellt: Ein Tabulator, ein Leerzeichen, oder nichts. Nur bei der Auswahl
Tabulator ist das nachfolgende Feld bei verfligbar.

* bei (Standard: abhangig von der Ebene): Nur wenn ein Tabulator auf die Nummerierung
folgt: Tabulator-Position. Ist der Abstand zum Nummerierungs-/Aufzéhlungszeichen zu
klein, so verschiebt das Zeichen den Text der ersten Zeile.

* Einzug bei (Standard: abh&ngig von der Ebene): Abstand vom linken Seitenrand bis zum
Beginn des Listentextes, der nach einem Zeilenumbruch der ersten Zeile folgt.
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* Ausgerichtet bei (Standard: abhangig von der Ebene): Abstand vom linken Seitenrand
zum Nummerierungssymbol.

* Ausrichtung der Nummerierung (Standard: Links): Die Ausrichtung des Nummerierungs-
symbols einschliel3liches des davor stehenden Textes:

° Links (Standard): Das Nummerierungssymbol beginnt an der durch das Feld Ausge-
richtet bei festgelegten Position.

° Rechts: Das Nummerierungssymbol endet vor der durch das Feld Ausgerichtet bei
festgelegten Position.

° Zentriert: Das Nummerierungssymbol wird zentriert um das durch das Feld Ausge-
richtet bei festgelegten Position angeordnet.

* Standard: Die Einrickungen und Abstande werden Uber die Schaltflache auf ihre Stan-
dardwerte zurlickgesetzt.

Achtung Die Option Ausrichtung der Nummerierung richtet das Nummerierungs-/Aufzah-
lungszeichen aus, wenn die Nummer grof3er werden und damit mehr Platz einneh-
men, z. B. groBer als 10. Die Option dient nicht der Absatzformatierung.
Normalerweise werden die Eintrage Nummerierung wird gefolgt von und Ein-

Tipp zug bei gleich gesetzt. Abbildung 48 zeigt die Auswirkungen der beiden Einstel-

lungen.

1. Das ist der erste Eintrag der ersten Ebene
einer numerischen Liste: Bei: 0,5 cm;
Einzug bei: 0,5 cm

2. Das ist der zweite Eintrag der ersten Ebene
einer numerischen Liste: Bei: 0,5 cm;
Einzug bei: 0,5 cm
1. Das ist der erste Eintrag der zweiten

Ebene einer numerischen Liste: Bei: 1,0
cm; Einzug bei: 1,0 cm

1. Das ist der erste Eintrag der ersten Ebene
einer numerischen Liste: Bei: 0,5 cm;
Einzug bei: 1,0 cm

2. Das ist der zweite Eintrag der ersten Ebene
einer numerischen Liste: Bei: 0,5 cm;
Einzug bei: 1,0 cm

1. Das ist der erste Eintrag der zweiten
Ebene einer numerischen Liste:
Bei: 1,0 cm; Einzug bei: 2,0 cm

Abbildung 48: Beispiel flir unterschiedliche Werte in den Feldern Bei und Einzug bei.

Abbildung 49 zeigt noch einmal die wesentlichen GroR3en zur Einstellung der Abstande in einer Lis-
tenvorlage:

Y ‘ A v s e T L B A
Zg —>I1.  Das ist ein Eintrag der ersten Ebene:
o Ausgerichtet bei: 1,0 cm; Bei:
c) *12,0 cm; Einzug bei: 3,0 cm

Abbildung 49: Listenvorlage mit verschiedenen Einstellungen fir die Felder:
a) Bei; b) Ausgerichtet bei; c) Einzug bei.

Die Seite Position unterscheidet sich im Aussehen bei Dokumenten, die die Posi-
tions- und Leerzeichenattribute benutzen, die mit OpenOffice.org 3.0 eingefiihrt

wurden (und in allen Versionen von LibreOffice benutzt werden), und Dokumenten,
die die alten Attribute der Versionen vor 3.0 benutzen. Die neue Version dieser Re-

Achtung

A
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gisterseite zeigt die Steuerelemente "Nummerierung wird gefolgt von", "Ausrich-
tung der Nummerierung”, "Ausgerichtet bei" und "Einzug bei". Die alte Version die-
ser Registerseite, die in einer alten nummerierten oder mit Aufzahlungszeichen
versehenen Liste zu sehen ist, zeigt die Steuerelemente "Einrlickung", "Breite der
Nummerierung", "Mindestabstand Nummer <-> Text" und "Ausrichtung der Num-
merierung”. Ausfiihrungen zur Bedeutung der Felder nach der alten Version finden
Sie im nachfolgenden Abschnitt und in der Hilfe auf der Seite Position.

Position fiir Dokumente, die mit dem ODF-Format 1.1 oder friiher erstellt wurden

Wenn Ihr Dokument mit ODF-Version 1.1 oder friher erstellt wurde, z. B. in einer alteren Version
von OpenOffice.org, und mit LibreOffice gedffnet wird, ist die Darstellung der Seite Position an-
ders als im Abschnitt Position auf Seite 53 beschrieben. Abbildung 50 zeigt die Seiten fur die ODF-
Version 1.1.

[ 5
Mummerierungsart: Nummerierung 1 &J

!‘u’erwalten Aufzihlungszeichen |Nummerierungsart | Gliederung Bille’Dsitinn IOptiu:rneni

Ebene  Position und Abstand
1 Eiki

2
3 [ Relativ
4
g Breite der Nurnmerierung 050cm 5
6
7 Mindestabstand Mummer <-> Text 000cm 5
8
9 Ausrichtung der Mummerierung ﬂ
10
1-10

| Standard

[ Ok ] [ Zuweisen ] l Abbrechen ‘ | Hilfe J [ Zurick ]

= 4

Abbildung 50: Das Dialogfenster Listenvorlage, Seite Position.

Der grundlegende Aufbau mit der Auswahl der Ebenen und dem Vorschaufenster ist gleich. Die un-
terschiedlichen Einstellmdglichkeiten werden hier beschrieben:

* Einzug (Standard: 0,0 cm): Abstand zwischen dem linken Seitenrand (bzw. dem linken
Rand des Textobjekts) und dem linken Rand des Nummerierungs-/Aufzéhlungszeichens
sein soll. Wenn in der aktuellen Absatzvorlage bereits ein Einzug definiert ist, wird der hier
eingegebene Abstand zu diesem Absatzeinzug aufaddiert.

* Relativ (Nur fir Ebenen gro3er 1): Der im Feld Einzug eingegebene Wert wird zum Einzug
der vorherigen Ebene addiert und gibt nicht den Abstand zum linken Rand an.

* Breite der Nummerierung (Standard: 0,50 cm): Abstand zwischen dem linken Rand des
Nummerierungs-/Aufzahlungszeichens und dem linken Textrand. (Breite fir Nummerie-
rungs-/Aufzahlungszeichen). Die angegebene Breite wird von Writer immer reserviert.
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* Mindestabstand Nummer <-> Text (Standard: 0,00 cm): Mindestabstand zwischen rech-
ten Rand des Nummerierungs-/Aufzéahlungszeichens und erster Zeile des Listentextes. Ist
der Abstand zum Text nicht ausreichend, wird Writer die Breite fir das Nummerierungs-/-
Aufzahlungszeichen vergréRern. Die Angabe eines Mindestabstandes ist sinnvoll bei
rechtsbiindigem Text, der auf die Nummerierung von rechts zulauft.

* Ausrichtung der Nummerierung (Standard: Links): Ausrichtung der Nummerierung ein-
schlie3lich des Textes vor und nach der Nummerierung.

* Standard: Die Einrickungen und Abstande werden Uber die Schaltflache auf ihre Stan-
dardwerte zurlickgesetzt.

Tipp

Optionen

Um zu verstehen, wie die Ausrichtung und Positionierung von Nummerierungen
funktioniert, erstellen Sie eine nummerierte Liste mit mehr als 10 Listeneintragen.
Stellen Sie die Abstande so ein, dass die breiteste Nummer mit zwei oder mehr
Zeichen genug Platz haben. Es kénnen auch mehr als zehn rechts ausgerichtete
Nummerierungszeichen sein.

Die Formatierungen fir Nummerierungen und Aufzahlungen werden auf der Seite Optionen
durchgefihrt. Sie konnen die einzelnen Ebenen separat formatieren. Der letzte Eintrag 1 — 10 er-
laubt die gleichzeitige Anderung aller Ebenen. Wahlen Sie zuerst die zu bearbeitende Ebene aus.
Wenn Sie auf den Seiten Aufzdhlungszeichen, Nummerierungsart oder Bild bereits eine Vor-
auswabhl getroffen haben, so wird die Seite Optionen angepasst und mit den entsprechenden Wer-
ten vorbelegt. Rechts befindet sich ein Vorschaufenster, das die Auswirkungen der getatigten Ein-

gaben anzeigt.

Im Bereich Listen kénnen Sie die Einstellungen vornehmen:

* Nummerierung (Standard: keiner, abhangig von Vorauswahl): Aus einer Auswabhlliste se-

lektieren Sie die gewinschte Nummerierungsart fur die Ebene (Tabelle 3).
Tabelle 3: Auswahl von Nummerierungsarten

Auswahl Kommentar

1,23, .. Arabische Ziffern

A B,C, .. GroRRbuchstaben

a,b,c,.. Kleinbuchstaben

[T 1 GrolRRe romische Ziffern

i, i, i, ... Kleine rémische Ziffern

A, .. AA . Alphabetische Nummerierung mit Gro3buchstaben

AAA, ...

a, .. aa, .. Alphabetische Nummerierung mit Kleinbuchstaben

aaa, ...

Bullet Figt am Zeilenanfang ein Aufzdhlungszeichen ein. Wéhlen Sie diese Option
aus, und klicken Sie auf die Schaltflache Zeichen, um einen Stil fiir das Auf-
z&hlungszeichen auszusuchen.

Aufzahlungszeichen werden an die aktuelle Zeilenhthe angepasst. Sie haben
die Mdglichkeit, den Aufzéhlungszeichen durch Auswahl einer Zeichenvorlage
eine andere Schriftgrof3e zu verleihen.

Grafik Zeigt eine Grafik als Aufzahlungszeichen an. Wahlen Sie zunachst diese Opti-
on aus, und klicken Sie dann auf Auswahl, um die gewiinschte Bilddatei aus-
zusuchen. Das Bild wird ins Dokument eingebettet.

Grafik ver- Zeigt ein Bild fur das Aufzahlungszeichen an. Wahlen Sie diese Option und
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Auswahl Kommentar

knUpft klicken Sie dann auf Auswahl, um das Bild zu wahlen, das Sie benutzen
mdchten. Das Bild wird als eine Verkniipfung zur Bilddatei eingefiigt.

Keine Es wird kein Nummerierungsstil angewendet.

Je nach Auswahl der Nummerierungsart sind nachfolgend weitere Felder verflgbar (Abbil-
dung 51). Die zugehdrigen Felder bei der Auswahl Bullet, Grafik oder Grafik verknuipft
werden weiter unten beschrieben.

[ 6]
Mummerierungsart: Mummerierung 1 w

!‘u’erwalten Au&ﬁhlungszeicheniNummerierungsart Gliederung|Bi|d|Position|OptiDﬂen |_

Ebene Listen

1 Nurnrmerierung |ir i, 1, . El 1
2 .
i- Zeichenvorlage |Nummerierungszeichen El {a)
2 Vollstindig 1 2] | i -
7 Trenner A.
8
9 Vor
10
1-10 Hinter

Beginn bei 1 =

Alle Ebenen
[T] Fertlaufende Nummerierung

0].4 ] l Zuweisen ] [ Abbrechen J I Hilfe ‘ l Zurick

= 4

Abbildung 51: Das Dialogfenster Listenvorlage, Seite Optionen und Aus-
wahl einer Nummerierungsart.

* Zeichenvorlage (Standard: Nummerierungszeichen): Zeichenvorlage fir die Nummerie-
rungszeichen. Angezeigt werden die im Fenster Formatvorlagen verfigbaren Zeichenvor-
lagen. Sind Zeichenvorlagen neu zu erstellen oder anzulegen, ist das im Fenster Format-
vorlagen durchzufuhren.

* Vollstandig (Standard: 1): Gibt an, wie viele Ebenen in der Nummerierung zu bericksichti-
gen sind.
Beispiel: FUr die erste Ebene wurde die Nummerierungsart "A, B, C..." und fur die zweite
Ebene die Nummerierungsart "1, 2, 3, ..." ausgewahlt, so wird fur Vollstandig = "2" die
zweite Ebene mit der Nummerierung "A.1", "A.2" usw. beginnen.

* Vor (Standard: Kein): Element (Zeichen, Zeichenfolge oder Text), das vor der Nummerie-
rung in der Liste angezeigt werden soll.
Beispiel: FUr eine Nummerierungsliste mit dem Format "Pkt. 1", geben Sie in dieses Feld
"Pkt. " ein. Vergessen Sie nicht ein Leerzeichen mit einzugeben, um "Pkt." von dem Num-
merierungszeichen "1" zu trennen.

* Hinter (Standard: "."): Element (Zeichen, Zeichenfolge oder Text), das nach der Nummerie-
rung in der Liste angezeigt werden soll.
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Beispiel: Fir eine Nummerierungsliste mit dem Format "1.)", geben Sie in dieses Feld ".)"
ein.

* Beginn bei (Standard: 1): Anfangsnummer fiir die aktuelle Ebene.
Beispiel: Eine Nummerierungsliste soll erst mit "10" beginnen, so geben Sie in dieses Feld
"10" ein.

Nummerierung: Auswahl Grafik und Grafik verkniipft

* Auswahl: Auswahl einer Grafik als Datei oder als Aufzahlungszeichen aus der mit LibreOf-
fice ausgelieferten Zeichen (Gallery).

Wenn Sie die Nummerierungsart Grafik verkniipft wahlen, wird im Dokument nur
Achtung der Pfad und der Dateiname zu der Grafikdatei hinterlegt. Wird das Dokument auf
einem anderen Rechner geéffnet, auf welchem die Datei nicht vorhanden ist oder
A der Pfad oder Dateiname falsch ist, so werden die Grafiken im Dokument nicht an-
gezeigt.

* Breite (Standard: 0,0 cm): Breite der Grafik.

* Hohe (Standard: 0,0 cm): Hohe der Grafik.

* Seitenverhiltnis beibehalten (Standard: Nicht aktiviert): Das Verhéltnis Hohe/Breite bleibt
bei der Skalierung erhalten.

* Ausrichtung (Standard: Basis oben): Ausrichtung der Grafik.

Nummerierung: Auswabhl Bullet

* Zeichenvorlage (Standard: Nummerierungszeichen): Zeichenvorlage fir die Nummerie-
rungszeichen. Angezeigt werden die im Fenster Formatvorlagen verfligbaren Zeichenvor-
lagen. Sind Zeichenvorlagen neu zu erstellen oder anzulegen, ist das im Fenster Format-
vorlagen durchzufthren.

* Zeichen: Die Schaltflache 6ffnet das Dialogfenster Sonderzeichen zur Auswahl eines Auf-
zahlungszeichen.

Im Bereich Alle Ebenen Legen Sie die Nummerierungsoptionen fir alle Ebenen fest:

* Fortlaufende Nummerierung (Standard: Nicht aktiviert): Alle Ebenen werden fortlaufend
nummeriert.

Listenvorlage in Absatzvorlage verwenden

Dir Verwendung von Listenvorlagen andert nicht die zugrunde liegende Absatzvorlage. Eine Liste
wird auch durch solche Eigenschaft wie Schriftart, Schriftgré3e, Zeilenabstand u. a. gekennzeich-
net. Daher kbnnte man erwarten, dass zuerst die Absatzvorlage und dann die Listenvorlage auszu-
wahlen/anzuwenden ist (oder umgekehrt). Aber es geht einfacher: Die Listenvorlage wird tiber die
Seite Gliederung & Nummerierung der Absatzvorlage eingebunden. Anschlie3end braucht nur
noch mit der Absatzvorlage gearbeitet werden, d. h. die Absatzvorlage dem Text zugeordnet wer-
den.

Dieser Abschnitt zeigt ein Beispiel fur die Verwendung von Listen- in Absatzvorlagen:
1) Erstellen Sie eine Listenvorlage, die Sie verwenden méchten, z. B. Meine Listenvorlage.
2) Erstellen Sie eine neue Absatzvorlage.
3) Auf der Seite Verwalten der Absatzvorlage:
a) Vergeben Sie im Feld Name eine aussagekréaftige Bezeichnung flr die Absatzvorlage,
Z. B. Nummerierter Absatz.
b) Im Feld Folgevorlage wird automatisch der neue Name eingetragen. Den lassen Sie
unverandert.
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c) Im Feld Verknuipft mit wahlen Sie den Eintrag -Keine-.
d) Das Feld Bereich lassen Sie auf Benutzervorlagen.

4) Richten Sie den Absatz nach lhren Winschen ein. Da die Einzlige durch die Listenvorlage
kontrolliert werden, andern Sie die Einstellungen dazu auf der Seite Einzlige und Abstan-
de nicht. Die Abstande die Uber und unter dem Absatz (Felder: Uber Absatz und Unter
Absatz) kbnnen Sie jedoch andern.

5) Auf der Seite Gliederung & Nummerierung wéhlen Sie im Feld Listenvorlage die eben
erstellte Listenvorlage Meine Listenvorlage aus.

6) Mit OK sichern Sie die Vorlage und verlassen das Dialogfenster.

Es ist allgemein Praxis und ein guter Stil, fir eine Liste mehrere Absatzvorlagen zu definieren, da-
von drei Absatzvorlagen fur die nummerierte Liste:

* Liste Einfiihrung: Absatzvorlage fur den einfiihrenden Text zur Liste, der vor dem ersten
Listeneintrag steht und noch nicht eingezogen ist. Der Abstand zum ersten Listeneintrag ist
etwas verkurzt, um die Zugehorigkeit des Textes zu betonen.

» Liste Start: Die Absatzvorlage fir das erste Listenelement. Der Abstand zum néchsten Lis-
teneintrag ist etwas verkirzt.

* Liste Inhalt: Die Absatzvorlage fir alle folgenden, aber ohne das letzte Listenelement. Der
Abstand zum néchsten Listeneintrag ist etwas verklrzt.

* Liste Ende: Die Absatzvorlage fur das letzte Listenelement. Der Abstand zum nachfolgen-
den Text sollte zur Abgrenzung etwas groRRer sein.

* Liste Ohne: Absatzvorlage fur einen nicht nummerierten Absatz, d. h. ein Absatz ohne
Nummerierungszeichen, um langere Texte auch mit Einzug unterhalb des Listeneintrags zu
schreiben. Diese Absatzvorlage sollte fur jede Listenebene erstellt werden.

Beispiel: Erstellen einer einfachen Liste

In diesem Beispiel wird eine nummerierte Liste erstellt, die die Lieder auf einer CD auflistet soll.
Die Nummerierung soll rechts ausgerichtet sein und zwischen dem Nummerierungszeichen und
dem Listentext soll ein Abstand eingehalten werden. Da die Liste auch fir andere CD's verwendet
werden soll, wird eine Listenvorlage erstellt.

Nummerierte Liste fiir die CD-Tracks

Offnen Sie das Formatvorlagenfenster (iiber die Funktionstaste F11, das Menii Format > Format-
vorlagen oder das Symbol || oder © in der Symbolleiste Format zu erreichen) und das Symbol
um die Listenvorlagen anzuzeigen. Mit einem Rechtsklick auf eine vorhandene Listenvorlage oder
in den leeren Bereich des Fensters Offnet sich ein Kontextmeni: Der Menlpunkt Neu 6ffnet ein
Dialogfenster zur Bearbeitung der Listenvorlage. Fir die Listenvorlage sind Eintragungen auf den
Seiten Verwalten, Position und Optionen vorzunehmen.

Auf der Seite Verwalten sind nachfolgende Felder anzupassen:
* Name: CD-Track
* Bereich: Benutzervorlagen.

Auf der Seite Position machen Sie dazu nachstehende Angaben:

* Ebene: 1
*  Nummerierung wird gefolgt von: Tabulator
e bei:4,0cm

* Einzug bei: 4,0 cm (Abstand vom linken Seitenrand bis zum Beginn des Listentextes, der
nach einem Zeilenumbruch der ersten Zeile folgt)

* Ausgerichtet bei: 1,5 cm (Abstand linker Seitenrand zum Nummerierungszeichen)

Listenvorlagen 59



* Ausrichtung der Nummerierung: Rechts.

Andern Sie die Seite Optionen wie folgt:
* Ebene: 1
*  Nummerierung: 1, 2, 3, ...
* Zeichenvorlage: keine
* Vollstandig: 1
e Vor: Kein Eintrag

* Hinter: "
* Beginn bei: 1.
* Fortlaufende Nummerierung: Nicht aktiviert.

Wie oben bereits dargestellt, ibernimmt die Liste die zugrunde liegende Absatzvorlage. Falls fir
die Nummerierung ein spezieller Zeichensatz, eine andere Schriftgrol3e oder -farbe erforderlich ist,
so erstellen Sie einen entsprechenden Zeichensatz und binden diesen auf der Seite Optionen un-
ter Zeichenvorlage ein.

Um das Wort Track vor die Nummerierung zu stellen, tragen Sie es in das Feld Vor ein. Achten Sie
darauf, dass nach dem Wort auch das Leerzeichen mit eingegeben wird, sonst erscheint die Num-
merierung direkt am Wort, so z. B. "Trackl1".

Nach Abschluss aller Einstellungen speichern Sie die Anderungen mit OK.

Mit der neuen Listenvorlage CD-Track arbeiten

Jetzt kdnnen Sie mit der neuen Listenvorlage arbeiten, die jetzt im gesamten Dokument als Vor-
lage verflgbar ist:

1) Mdchten Sie die Listenvorlage nutzen, erzeugen Sie mit Enter einen neuen Absatz (neue
Zeile).

2) Doppelklicken Sie im Formatvorlagenfenster bei den Listenvorlagen auf Ihren neue Listen-
vorlage CD-Track.

Wenn Sie bereits eine Liste haben, die Sie nach dem Vorbild von CD-Track formatieren wollen,
markieren Sie die Liste und doppelklicken Sie anschliel3end auf Ihre Listenvorlage CD-Track.

Beachten Sie, dass die Listenvorlage nicht die zugrunde liegende Absatzvorlage
Notiz beeinflusst. Deshalb sollten Sie vorher die Absatzvorlage priifen, ob diese lhren
Anspriichen genugt.

Wenn Sie mehr als zwei Listen in lhrem Dokument erstellen, wird die zweite Liste die Nummerie-

rung der ersten Liste fortflihren. Um auch bei der ersten Liste mit 1 zu starten, platzieren Sie den

Cursor irgendwo in die Liste und wéahlen nach einem Rechtsklick aus dem Kontextmeni Numme-
rierung neu beginnen.

Um die Nummerierung ein- oder auszuschalten, klicken Sie auf das Symbol Nummerierung
ein/aus oder verwenden die Sondertaste F12; um die Nummerierung nur auszuschalten verwen-
den Sie die Tastenkombination Strg+Umschalt+F12.
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